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Using This Manual

This preface is divided into the following sections:

1.The Contents of This Manual

2.The Contents of the FLUENT Manuals

3.Typographical Conventions

4.Technical Support

1. The Contents of This Manual

This document provides information about using the FLUENT application within Workbench.

A brief description of what is in each chapter follows:

• Getting Started With FLUENT in Workbench (p. 1), describes an overview of FLUENT within Workbench.

• Working With FLUENT in Workbench (p. 23), describes the details of using FLUENT within Workbench.

• Appendix A (p. 69), describes the differences in the FLUENT  File menu within Workbench.

2. The Contents of the FLUENT Manuals

The manuals listed below form the FLUENT product documentation set. They include descriptions of

the procedures, commands, and theoretical details needed to use FLUENT products.

FLUENT Getting Started Guide contains general information about getting started with using

FLUENT.

FLUENT User's Guide contains detailed information about using FLUENT, including information

about the user interface, reading and writing files, defining boundary conditions, setting up

physical models, calculating a solution, and analyzing your results.

FLUENT in Workbench User's Guide contains information about getting started with and using

FLUENT within the Workbench environment.

FLUENT Theory Guide contains reference information for how the physical models are imple-

mented in FLUENT.

FLUENT UDF Manual contains information about writing and using user-defined functions

(UDFs).

FLUENT Tutorial Guide contains a number of example problems with detailed instructions,

commentary, and postprocessing of results.

FLUENT Text Command List contains a brief description of each of the commands in FLUENT’s

text interface.

FLUENT Adjoint Solver Module Manual contains information about the background and usage

of FLUENT's Adjoint Solver Module that allows you to obtain detailed sensitivity data for the

performance of a fluid system.

FLUENT Battery Module Manual contains information about the background and usage of

FLUENT's Battery Module that allows you to analyze the behavior of electric batteries.

FLUENT Continuous Fiber Module Manual contains information about the background and usage

of FLUENT's Continuous Fiber Module that allows you to analyze the behavior of fiber flow,

fiber properties, and coupling between fibers and the surrounding fluid due to the strong inter-

action that exists between the fibers and the surrounding gas.

FLUENT Fuel Cell Modules Manual contains information about the background and the usage

of two separate add-on fuel cell models for FLUENT that allow you to model polymer electrolyte

membrane fuel cells (PEMFC), solid oxide fuel cells (SOFC), and electrolysis with FLUENT.
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FLUENT Magnetohydrodynamics (MHD) Module Manual contains information about the back-

ground and usage of FLUENT's Magnetohydrodynamics (MHD) Module that allows you to analyze

the behavior of electrically conducting fluid flow under the influence of constant (DC) or oscil-

lating (AC) electromagnetic fields.

FLUENT Migration Manual contains information about transitioning from the previous release

of FLUENT, including details about new features, solution changes, and text command list

changes.

FLUENT Population Balance Module Manual contains information about the background and

usage of FLUENT's Population Balance Module that allows you to analyze multiphase flows in-

volving size distributions where particle population (as well as momentum, mass, and energy)

require a balance equation.

Running FLUENT Under LSF contains information about the using FLUENT with Platform Com-

puting’s LSF software, a distributed computing resource management tool.

Running FLUENT Under PBS Professional contains information about the using FLUENT with

Altair PBS Professional, an open workload management tool for local and distributed environ-

ments.

Running FLUENT Under SGE contains information about the using FLUENT with Sun Grid Engine

(SGE) software, a distributed computing resource management tool.

3. Typographical Conventions

Several typographical conventions are used in this manual’s text to facilitate your learning process.

• Different type styles are used to indicate graphical user interface menu items and text interface menu

items (for example, Iso-Surface dialog box, surface/iso-surface  command).

• The text interface type style is also used when illustrating exactly what appears on the screen or exactly

what you need to type into a field in a dialog box. The information displayed on the screen is enclosed

in a large box to distinguish it from the narrative text, and user inputs are often enclosed in smaller

boxes.

• A mini flow chart is used to guide you through the navigation pane, which leads you to a specific task

page or dialog box. For example,

Models → Multiphase → Edit...

indicates that Models is selected in the navigation pane, which then opens the corresponding task

page. In the Models task page, Multiphase is selected from the list. Clicking the Edit... button

opens the Multiphase dialog box.

Also, a mini flow chart is used to indicate the menu selections that lead you to a specific command

or dialog box. For example,

Define → Injections...

indicates that the Injections... menu item can be selected from the Define pull-down menu, and

display  → mesh

indicates that the mesh command is available in the display  text menu.

In this manual, mini flow charts usually precede a description of a dialog box or command, or a

screen illustration showing how to use the dialog box or command. They allow you to look up in-

formation about a command or dialog box and quickly determine how to access it without having

to search the preceding material.
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• The menu selections that will lead you to a particular dialog box or task page are also indicated (usually

within a paragraph) using a "/". For example, Define/Materials... tells you to choose the Materials...

menu item from the Define pull-down menu.

4. Technical Support

If you encounter difficulties while using ANSYS FLUENT, please first refer to the section(s) of the

manual containing information on the commands you are trying to use or the type of problem you are

trying to solve. The product documentation is available from the online help, or from the ANSYS Cus-

tomer Portal (www.ansys.com/customerportal).

If you encounter an error, please write down the exact error message that appeared and note as much

information as you can about what you were doing in ANSYS FLUENT.

Technical Support for ANSYS, Inc. products is provided either by ANSYS, Inc. directly or by one of our

certified ANSYS Support Providers. Please check with the ANSYS Support Coordinator (ASC) at your

company to determine who provides support for your company, or go to www.ansys.com and select

About ANSYS> Contacts and Locations. The direct URL is: http://www1.ansys.com/customer/public/sup-

portlist.asp. Follow the on-screen instructions to obtain your support provider contact information. You

will need your customer number. If you don't know your customer number, contact the ASC at your

company.

If your support is provided by ANSYS, Inc. directly, Technical Support can be accessed quickly and effi-

ciently from the ANSYS Customer Portal, which is available from the ANSYS Website (www.ansys.com)

under Support> Technical Support where the Customer Portal is located. The direct URL is: ht-

tp://www.ansys.com/customerportal.

One of the many useful features of the Customer Portal is the Knowledge Resources Search, which can

be found on the Home page of the Customer Portal.

Systems and installation Knowledge Resources are easily accessible via the Customer Portal by using

the following keywords in the search box: Systems/Installation . These Knowledge Resources

provide solutions and guidance on how to resolve installation and licensing issues quickly.

NORTH AMERICA

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Toll-Free Telephone: 1.800.711.7199

Fax: 1.724.514.5096

Support for University customers is provided only through the ANSYS Customer Portal.

GERMANY

ANSYS Mechanical Products

Telephone: +49 (0) 8092 7005-55

Email: support@cadfem.de

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.
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National Toll-Free Telephone:

German language: 0800 181 8499

English language: 0800 181 1565

International Telephone:

German language: +49 6151 3644 300

English language: +49 6151 3644 400

Email: support-germany@ansys.com

UNITED KINGDOM

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +44 (0) 870 142 0300

Fax: +44 (0) 870 142 0302

Email: support-uk@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

JAPAN

CFX , ICEM CFD and Mechanical Products

Telephone: +81-3-5324-8333

Fax: +81-3-5324-7308

Email: CFX: japan-cfx-support@ansys.com; Mechanical: japan-ansys-support@ansys.com

FLUENT Products

Telephone: +81-3-5324-7305

Email: FLUENT: japan-fluent-support@ansys.com;POLYFLOW: japan-polyflow-support@ansys.com;FfC: japan-

ffc-support@ansys.com; FloWizard: japan-flowizard-support@ansys.com

Icepak

Telephone: +81-3-5324-7444

Email: japan-icepak-support@ansys.com

Licensing and Installation

Email: japan-license-support@ansys.com

INDIA

ANSYS Products (including FLUENT, CFX, ICEM-CFD)

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +91 1 800 233 3475 (toll free) or +91 1 800 209 3475 (toll free)

Fax: +91 80 2529 1271
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Email: FEA products: feasup-india@ansys.com;CFD products: cfdsup-india@ansys.com; Installation: installation-

india@ansys.com

FRANCE

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Toll-Free Telephone: +33 (0) 800 919 225

Email: support-france@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

BELGIUM

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +32 (0) 10 45 28 61

Email: support-belgium@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

SWEDEN

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +44 (0) 870 142 0300

Email: support-sweden@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

SPAIN and PORTUGAL

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +33 1 30 60 15 63

Email: support-spain@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.

ITALY

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://www.ansys.com/customerportal) and select the appropriate

option.

Telephone: +39 02 89013378

Email: support-italy@ansys.com

Support for University customers is provided only through the ANSYS Customer Portal.
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Chapter 1: Getting Started With FLUENT in Workbench

This document is designed to provide information about using FLUENT within ANSYS Workbench. Some

basic information about using Workbench is provided here, but the majority of the information about

using Workbench can be found in the Workbench on-line documentation.

This chapter provides some basic instructions for getting started with using FLUENT in Workbench.

1.1. Introduction to Workbench

1.2.The Workbench Graphical User Interface

1.3. Creating FLUENT-Based Systems

1.4. Understanding Cell States with FLUENT in Workbench

1.5. Starting FLUENT in Workbench

1.6. Saving Your Work in FLUENT with Workbench

1.7. Exiting FLUENT and Workbench

1.8. An Example of a FLUENT Analysis in Workbench

1.9. Getting Help for FLUENT in Workbench

1.1. Introduction to Workbench

ANSYS Workbench combines access to ANSYS applications with utilities that manage the product

workflow.

Applications that can be accessed from Workbench include: ANSYS DesignModeler (for geometry creation);

ANSYS Meshing (for mesh generation); ANSYS FLUENT or CFX (for setting up and solving fluid dynamics

analyses); and ANSYS CFD-Post (for postprocessing the results). In Workbench, a project is composed

of a group of systems. The project is driven by a schematic workflow that manages the connections

between the systems. From the schematic, you can interact with workspaces that are native to Work-

bench, such as Design Exploration (parameters and design points), and you can launch applications

that are data-integrated with Workbench (such as ANSYS FLUENT or CFX). Data-integrated applications

have separate interfaces, but their data is part of the Workbench project and is automatically saved and

shared with other applications as needed. This makes the process of creating and running a CFD simu-

lation more streamlined and efficient.

Workbench allows you to construct projects composed of multiple dependent systems that can be up-

dated sequentially based on a workflow defined by the project schematic. For instance, you can construct

a project using two connected FLUENT-based systems where the two systems share the same geometry

and mesh; and the second system uses data from the first system as its initial solution data. When you

have two systems connected in this way, you can modify the shared geometry once and then update

the results for both systems with a single mouse click without having to open the ANSYS Meshing ap-

plication or FLUENT. Some examples of when this is useful include: performing a reacting flow analysis

starting from the solution obtained from a cold flow analysis; performing a second order analysis

starting from the solution obtained from a first order analysis; and performing a transient simulation

starting from the solution obtained from a steady-state analysis.

In addition, Workbench also allows you to copy systems in order to efficiently perform and compare

multiple similar analyses. Workbench also provides a parametric modeling capabilities in conjunction

1
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with optimization techniques to allow you to efficiently investigate the effects of input parameters on

selected output parameters.

For more information, please see the following section:

1.1.1. Limitations

1.1.1. Limitations

The following limitations are known when using FLUENT in Workbench:

• Workbench units and options are not passed to FLUENT.

• The text user interface (TUI) shortcuts, or aliases, for reading case and data files for FLUENT in Work-

bench are disabled by design. For example, file read-case , f read-case , and f r-c  can be

used, however f rc  cannot be used.

• The version of FLUENT used under Workbench must always be the version of FLUENT that was packaged

and installed with that version of ANSYS Workbench. It is not possible to use previous versions of FLU-

ENT under Workbench even through a FLUENT Inc.  environment variable.

• Graphical user interface (GUI) journal files in FLUENT 14.0 are not backwards compatible. That is,

Workbench journal files (*.wbjn  files) created in version 12.0 or version 12.1 that contain FLUENT GUI

commands may need to be recreated if they fail due to a change in the FLUENT graphical user interface

or a string used therein.

• For older FLUENT in Workbench projects (prior to version 14.0), when making any changes to the mesh

using ANSYS Meshing (e.g., renaming a surface), you should first open FLUENT using the Setup cell of

the Fluid Flow (FLUENT) analysis system in order for FLUENT to be aware of the upstream mesh changes

(e.g., when detecting upstream zone name changes).

• Under Workbench, the Microsoft Job Scheduler cannot be used to run FLUENT in serial.

• The coupling between Ansoft and FLUENT in Workbench is not supported on Windows Vista (32 bit

and 64 bit), Red Hat 6, and SUSE Linux Enterprise Server 11.

• Changing the meshing method to "Assembly Meshing" methods (e.g., CutCell) from other meshing

methods may not preserve the previously defined contact regions. Currently, the FLUENT simulation

workflow does not support this type of change.

Note

ANSYS FLUENT only allows a period to be used as a decimal separator. If your system is set

to a European locale that uses a comma separator (e.g., Germany), fields that accept numeric

input may accept a comma, but may ignore everything after the comma. If your system is

set to a non-European locale, numeric fields will not accept a comma at all.

ANSYS Workbench accepts commas as decimal delimiters. These are translated into periods

when data is passed to ANSYS FLUENT.

1.2. The Workbench Graphical User Interface

The Workbench graphical user interface (Figure 1.1 (p. 3)) consists of the Toolbox, the Project Schem-

atic, the Toolbar, and the Menu bar. The most common way to begin work in Workbench is to drag an

item, such as a component system (application) or an analysis system, from the Toolbox to the Project

Schematic, or to double-click an item to initiate the default action. You will view your component and/or

analysis systems – the pieces that make up your analysis – in the Project Schematic, including all con-

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.2

Chapter 1: Getting Started With FLUENT in Workbench



nections between the systems. The individual applications in which you work will display separately

from the Workbench graphical interface, but the actions you take in the applications will be reflected

in the Project Schematic.

Important

Note that FLUENT can be accessed in Workbench as either a component system or as an

analysis system. Details for using both are described throughout this document.

Figure 1.1  The Workbench Graphical User Interface
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Important

Note that FLUENT in Workbench uses informational, question, and warning dialog boxes that

are designed to guide you in various ways as you work through your CFD analysis. Informa-

tional dialog boxes display messages that assist you in a specific task, or provide additional

information relating to the task at hand. Question dialog boxes present questions concerning

a task that is about to be performed, displaying an OK and a Cancel button in order to allow

you to choose from one of two options (to proceed or not to proceed). Warning dialog boxes

contain only an OK button and are designed to display a cautionary message indicating that

you need to be aware that the application is about to change something or has internally

changed something to maintain the consistency.

Note

You can set various FLUENT–specific preferences in Workbench (e.g., Launcher settings, color

scheme, etc.). For more information, see Configuring ANSYS Workbench in the Workbench

User Guide.

1.3. Creating FLUENT-Based Systems

There are two basic types of systems: analysis systems and component systems. The Fluid Flow (FLUENT)

analysis system allows you to perform a complete CFD analysis and contains cells that allow you to:

create geometry, generate a mesh, specify settings in FLUENT, run the FLUENT solver, and visualize the

results in CFD-Post.

The FLUENT component system allows you to access the FLUENT application from within Workbench and

contains only the cells needed to specify settings in FLUENT and run the FLUENT solver. When using a

FLUENT component system, a mesh must be imported into the system or provided through a connection

from an upstream system.

Important

A separate cell for results visualization is only needed when using CFD-Post. The post-pro-

cessing capabilities in FLUENT can be accessed from both the Fluid Flow (FLUENT) analysis

system and the FLUENT component system.

For more information, please see the following sections:

1.3.1. Creating FLUENT-Based Analysis Systems

1.3.2. Creating FLUENT-Based Component Systems

1.3.1. Creating FLUENT-Based Analysis Systems

You can create a Fluid Flow (FLUENT) analysis system in Workbench by double-clicking on Fluid Flow

(FLUENT) under Analysis Systems in the Toolbox.

Important

You can also create a Fluid Flow (FLUENT) analysis system by left-clicking on Fluid Flow

(FLUENT) under Analysis Systems in the Toolbox, and then dragging it onto the Project

Schematic.
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Figure 1.2  Selecting the Fluid Flow (FLUENT) Analysis System in Workbench

The new Fluid Flow (FLUENT) analysis system appears in the Project Schematic as a box containing

several cells (Figure 1.3 (p. 7)). Each cell corresponds to a typical task you would perform to complete

a CFD analysis. The following cells are available in a Fluid Flow (FLUENT) analysis system:

Geometry

allows you to define the geometrical constraints of your analysis. You can use the context menu (by

right-clicking on the cell) to import a pre-existing geometry into the system. Double-clicking on the

Geometry cell opens ANSYS DesignModeler where you can create a new geometry or modify an existing

geometry.

Mesh

allows you to define and generate a computational mesh for your analysis. Double-clicking on the Mesh

cell opens ANSYS Meshing and loads the current mesh database (or the geometry defined by the Geo-

metry cell) if you have not yet begun working on the mesh. Alternatively, you can use the context menu

(by right-clicking on the Mesh cell) to import a pre-existing FLUENT mesh into the system.
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Important

Importing a FLUENT mesh file into the Mesh cell results in the Mesh cell becoming the

starting point for your analysis (and the name of the Mesh cell changes to Imported

Mesh). Therefore, the Geometry cell (and data it contains) will be deleted from the system.

The deleted Geometry cell can be retrieved by selecting Reset from the context menu

of the Imported Mesh cell.

Important

FLUENT meshes imported into the Mesh cell cannot be modified by the ANSYS Mesh-

ing application.

Setup

allows you to define the boundary conditions, physical models and solver settings for the FLUENT ana-

lysis. Double-clicking on the Setup cell opens FLUENT and loads the mesh defined by the Mesh cell as

well as any FLUENT settings that have already been specified. Alternatively, you can use the context

menu (by right-clicking on the Setup cell) to import a pre-existing FLUENT case or mesh file into the

system. After you specify the file you want to import, FLUENT will open and load the file.

Important

If you open FLUENT before defining a mesh, FLUENT will open without loading any files.

You can then choose to import files from the File menu in FLUENT.

Important

Importing a FLUENT case or mesh file into the Setup cell or the FLUENT application results

in the Setup cell becoming the starting point for your analysis. Therefore, the Geometry

and Mesh cells (and any data they contain) will be deleted from the system.

Solution

allows you to calculate a solution in FLUENT. Double-clicking on the Solution cell opens FLUENT and

loads the current FLUENT case and data files. If you have not yet performed any calculations, FLUENT will

load the mesh file as well as any settings that have been specified.

Important

You can also use the Solution cell context menu to import a pre-existing FLUENT data

file to use for initial solution data. If you have not yet performed any calculations, FLU-

ENT will load this data file in addition to the mesh and settings.

Results

allows you to display and analyze the results of the CFD analysis. Double-clicking on the Results cell

opens CFD-Post and loads the current FLUENT case and data files as well as the current CFD-Post state

file.
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Figure 1.3  A Fluid Flow (FLUENT) Analysis System

Note

While it is possible to apply different names for the Setup or the Solution cells by right-

clicking either cell, and selecting the Rename option in the context menu, it is not generally

recommended to do so.

1.3.2. Creating FLUENT-Based Component Systems

Similarly, you can create a FLUENT-based component system in Workbench by double-clicking FLUENT

under Component Systems.

Important

You can also create a FLUENT component system by left-clicking on FLUENT under Component

Systems in the Toolbox, and then dragging it onto the Project Schematic.

Figure 1.4  Selecting the FLUENT Component System in Workbench

The new FLUENT component system appears in the Project Schematic as a box containing two cells:

the Setup cell and the Solution cell (Figure 1.5 (p. 8)). The Setup and Solution cells in a FLUENT com-

ponent system work in the same manner as described above for the Fluid Flow (FLUENT) analysis
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system. The only difference is that the mesh must originate from a file imported into the Setup cell or

the FLUENT application, or it must be provided through a connection from an upstream system.

Figure 1.5  A FLUENT Component System

1.4. Understanding Cell States with FLUENT in Workbench

Workbench integrates multiple data-integrated (e.g., FLUENT) and native applications into a single,

seamless project flow, where individual cells can obtain data from and provide data to other cells.

Workbench provides visual indications of a cell’s state via icons on the right side of each cell. Brief de-

scriptions of the each possible state are provided below. For more information about cell states, see

the Workbench on-line help:

• Unfulfilled ( ) indicates that required upstream data does not exist. For example, when you first create

a new Fluid Flow (FLUENT) analysis system, all cells downstream of the Geometry cell appear as Un-

fulfilled because you have not yet specified a geometry for the system.

• Refresh Required ( ) indicates that upstream data has changed since the last refresh or update. For

example, after you assign a geometry to the Geometry cell in your new Fluid Flow (FLUENT) analysis

system, the Mesh cell appears as Refresh Required since the geometry data has not yet been passed

from the Geometry cell to the Mesh cell.

• Attention Required ( ) indicates that the current upstream data has been passed to the cell, however,

you must take some action to proceed. For example, after you launch FLUENT from the Setup cell in a

Fluid Flow (FLUENT) analysis system that has a valid mesh, the Setup cell appears as Attention Required

because additional data must be entered in FLUENT before you can calculate a solution.

• Update Required ( ) indicates that local data has changed and the output of the cell needs to be re-

generated. For example, after you launch ANSYS Meshing from the Mesh cell in a Fluid Flow (FLUENT)

analysis system that has a valid geometry, the Mesh cell appears as Update Required because the

Mesh cell has all the data it needs to generate a FLUENT mesh file, but the FLUENT mesh file has not

yet been generated.

• Up-To-Date ( ) indicates that an update has been performed on the cell and no failures have occurred

(or an interactive calculation has been completed successfully). For example, after FLUENT finishes per-

forming the number of iterations that you request, the Solution cell appears as Up-to-Date.

• Interrupted ( ) indicates that you have interrupted an update (or canceled an interactive calculation

that is in progress). For example, if you select the Cancel button in FLUENT while it is iterating, FLU-

ENT completes the current iteration and then the Solution cell appears as Interrupted.

• Input Changes Pending ( ) indicates that the cell is locally up-to-date, but may change when next

updated as a result of changes made to upstream cells. For example, if you change the Mesh in an Up-

to-Date Fluid Flow (FLUENT) analysis system, the Setup cell appears as Refresh Required, and the

Solution and Results cells appear as Input Changes Pending.
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• Pending ( ) indicates that a batch or asynchronous solution is in progress. When a cell enters the

Pending state, you can interact with the project to exit Workbench or work with other parts of the

project. If you make changes to the project that are upstream of the updating cell, then the cell will

not be in an up-to-date state when the solution completes.

If a particular action fails, Workbench provides a visual indication as well. Brief descriptions of the failure

states are described below.

• Refresh Failed, Refresh Required ( ) indicates that the last attempt to refresh cell input data failed, and

so the cell needs to be refreshed.

• Update Failed, Update Required ( ) indicates that the last attempt to update the cell and calculate

output data failed, and so the cell needs to be updated.

• Update Failed, Attention Required ( ) indicates that the last attempt to update the cell and calculate

output data failed, and so the cell requires attention.

If an action results in a failure state, you can view any related error messages in the Messages window

by clicking the Show Messages button on the lower right portion of Workbench.

1.5. Starting FLUENT in Workbench

This section describes how to start FLUENT in Workbench using FLUENT-based systems and how you

can use FLUENT Launcher within Workbench.

For more information, please see the following sections:

1.5.1. Starting FLUENT from a FLUENT-Based System

1.5.2. Specifying FLUENT Launcher Settings Within Workbench

1.5.1. Starting FLUENT from a FLUENT-Based System

You can start ANSYS FLUENT by double-clicking on the Setup cell in a Fluid Flow (FLUENT) analysis

system or a FLUENT component system. FLUENT launches and loads the Setup cell’s input data (e.g.,

mesh) and the Setup cell’s local data, if it exists (e.g., FLUENT settings). If no mesh has been specified,

FLUENT launches and waits for your input.

You can also start ANSYS FLUENT by double-clicking on the Solution cell in a Fluid Flow (FLUENT)

analysis system or a FLUENT component system. FLUENT launches and loads the current case and data

files, as well as the Setup cell’s input data (e.g., mesh), the Setup cell’s local data, if it exists (e.g., FLU-

ENT settings), and the Solution cell’s initial data, if it exists. If no mesh has been specified, FLU-

ENT launches and waits for your input.

Important

When FLUENT is launched from the Setup cell, it loads only the mesh and settings that served

as the starting point for your analysis and are associated with the Setup cell. In order to load

the current case and data files or the initial data file, you must launch FLUENT from the

Solution cell.

1.5.2. Specifying FLUENT Launcher Settings Within Workbench

You can use FLUENT in Workbench on either Windows or Linux machines, both interactively and in

batch mode. You can also start FLUENT on Linux from a Workbench session running on Windows and
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you can use the same FLUENT-specific project (and related files) in Workbench using both Linux and

Windows hardware interchangeably. The information is this section is the same for both Windows and

Linux, except where noted.

When you start ANSYS FLUENT from either type of FLUENT-based system within Workbench, FLUENT

Launcher will appear by default. Most FLUENT Launcher settings are available, except for the following

options:

• Version (disabled)

• Working Directory (disabled)

• Use Journal File (not available)

The Do not show this panel again option allows you to bypass FLUENT Launcher for subsequent

FLUENT sessions. This option is only available when running FLUENT in Workbench.

Important

When using LSF to schedule a FLUENT run from Workbench, by default the working directory

is used for checkpointing. You can specify an alternate directory for checkpointing using the

LSB_CHKPNT_DIR environment variable.

Important

Note that, when using FLUENT with Workbench on Linux, the FLUENT Root Path option is

disabled in the General tab of FLUENT Launcher.

To start your FLUENT simulation on a Linux cluster from a Workbench session running on Windows, use

the Use Remote Linux Nodes option in FLUENT Launcher. This option is available when the Parallel

option is enabled under Processing Options. Once this option is enabled, the Remote tab is visible

when you click the Show More Options button.

Important

The Remote tab of FLUENT Launcher can only be used for 64-bit Linux machines.

For more information about FLUENT Launcher, see Starting ANSYS FLUENT Using FLUENT Launcher. For

more information about using FLUENT Launcher to access remote Linux clusters, see Setting Remote

Options in FLUENT Launcher.

1.5.2.1. Specifying FLUENT Launcher Settings Using Cell Properties

You can view the properties of a selected cell in Workbench by selecting the Properties option under

the View menu, or by right-clicking a cell and selecting Properties from the context menu. The prop-

erties of the selected cell are displayed in the Properties Window in Workbench.
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Figure 1.6  Properties for FLUENT-Based Systems in Workbench

The FLUENT-based system Setup and Solution cells have the following properties that you can set for

FLUENT Launcher:

Use Setup Launcher Settings

(for Solution cells only) allows you to specify that the current systems Solution cell should use the

FLUENT Launcher property settings from the current system’s Setup cell.

Precision

allows you to choose either the single-precision or the double-precision solver

Show Launcher at Startup

allows you to show or hide FLUENT Launcher when FLUENT starts.

Display Mesh After Reading

allows you to show or hide the mesh after the mesh or case/data is read into FLUENT.

Embed Graphics Windows

allows you to embed the graphics windows in the FLUENT application window, or to have them free-

standing.

Use Workbench Color Scheme

allows you to use either the classic black background color in the graphics window, or to use the

Workbench color scheme.

Setup Compilation Environment for UDF

allows you to specify compiler settings for compiling user-defined functions (UDFs) with FLUENT.

Use Job Scheduler

allows you to specify settings for running FLUENT with the available job scheduler. On Linux, you can

use either LSF, SGE, or PBS Pro, as the job scheduler. On Windows, you can use the Microsoft Job
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Scheduler, or, when Run Parallel Version and Use Remote Linux Nodes are selected, you can use the

LSF, SGE, or PBS Pro job schedulers.

Run Parallel Version

allows you to choose to run the parallel version of FLUENT or not.

UDF Compilation Script Path

(if Setup Compilation Environment for UDF is selected) allows you to specify the path to the UDF

compilation script.

Use Remote Linux Nodes

(available only when Run Parallel Version is selected) allows you to run your FLUENT simulation on 64-

bit Linux machines.

If Run Parallel Version is selected, the following additional properties are available:

Number of Processors

allows you to set the number of processors you wish to use for the parallel calculations (e.g., 2, 4, etc.).

Interconnect

allows you to set the interconnects you wish to use for the parallel calculations (e.g., ethernet, myrinet,

infiniband, etc.).

MPI Type

allows you to set the MPI type you wish to use for the parallel calculations (e.g., MPICH2, Platform, etc.).

Use Shared Memory

allows you to specify if shared memory is to be used or not.

Machine Specification

(if Use Shared Memory is not selected) allows you to specify a list of machine names, or a file that

contains machine names.

Machine List

(if Use Shared Memory is not selected and Machine List is selected as the Machine Specification) allows

you to specify a list of machine names to run the parallel job.

Machine Filename

(if Use Shared Memory is not selected and File Containing Machine List is selected as the Machine

Specification) allows you to specify the name of the file that contains a list of machines to run the

parallel job.

If Use Remote Linux Nodes is selected, the following additional properties are available (for 64-bit

Linux machines only):

Remote FLUENT Root Path

allows you to specify the remote FLUENT Linux installation root path.

Use Specified Remote Working Directory

allows you to specify a directory other than temp  directory as the working directory for the remote

Linux nodes. When this property is selected, you can specify the directory in the Remote Working Dir-

ectory property that appears.

Remote Spawn Command

allows you to specify the command to connect to the remote node (the default is RSH).

Use Remote Cluster Head Node

allows you to specify the remote node that FLUENT will connect to for spawning (e.g., via rsh  or ssh ).

When this property is selected, you can specify the remote node in the Remote Host Name property

that appears.
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Important

When the PBS Pro option is selected for the Job Scheduler, the host specified in the

Use Remote Cluster Head Node field should be the PBS Pro submission host.

If Use Job Scheduler is selected, the following additional properties are available:

Computer Cluster Head Node Name

allows you to specify the name of the compute cluster head node.

Job Template

(available only when running Windows HPC 2008 Server Scheduler) allows you to create a custom sub-

mission policy to define the job parameters for an application. The cluster administrator can use job

templates to manage job submission and optimize cluster usage.

Node Group

(available only when running Windows HPC 2008 Server Scheduler) allows you to specify a collection of

nodes. Cluster administrators can create groups and assign nodes to one or more groups.

Processor Unit

(available only when running Windows HPC 2008 Server Scheduler) allows you to choose the following:

• Core refers to a single, named host in the cluster.

• Socket refers to a set of processors with a dedicated memory bus. This is also known as a non-

uniform memory access (NUMA) node.

• Node refers to an individual CPU on a node. For example, a dual-core processor is considered two

cores.

For more information about running FLUENT jobs using the Windows HPC 2008 Server Scheduler,

see the Frequently Asked Questions section of the Customer Portal.

Start When Resources Are Available

allows you to start the job when resources are available or not.

Create Job Submission XML

allows you to create the job submission XML file.

Job Submission XML File

(if Create Job Submission XML is selected) allows you to specify the name of the job submission XML

file.

If Use Job Scheduler and Use Remote Linux Nodes are selected, the following additional properties

are available:

Job Scheduler

allow you to specify the job scheduler for the remote Linux nodes. Available options are LSF (the default),

SGE, or PBS Pro.

If LSF is selected as the job scheduler, the following additional properties are available:

Use LSF Queue

allows you to use an LSF queue.

LSF Queue

(when Use LSF Queue is selected) allows you to specify the name of the LSF queue.

Use Checkpointing

allows you to use checkpointing with LSF.
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Enable Automatic Checkpointing

(when Use Checkpointing is selected) allows you to automatically checkpoint within a specific

period of time.

Checkpointing Period

(when Use Checkpointing and Enable Automatic Checkpointing are selected) allows you to specify

a time period for automatic checkpointing.

Important

When using LSF to schedule a FLUENT run from Workbench, by default the working dir-

ectory is used for checkpointing. You can specify an alternate directory for checkpointing

using the LSB_CHKPNT_DIR environment variable.

If SGE is selected as the job scheduler, the following additional properties are available:

SGE Qmaster

allows you to set the machine in the SGE job submission host list.

SGE Queue

allows you to set the queue where you want to submit your FLUENT jobs. Leave this field blank if

you want to use the default queue.

SGE PE

allows you to set the parallel environment where you want to submit your FLUENT jobs. Leave this

field blank if you want to use the default parallel environment.

Use SGE Settings

allows you to use SGE settings.

SGE Settings

(when Use SGE Settings is selected) allows you to specify SGE settings.

Important

When running FLUENT in Workbench via SGE, there may be instances when not

enough time is allotted for FLUENT to start. By default, Workbench performs two

steps: starting the FLUENT process and establishing initial contact, with a default wait

time of one minute; completing the FLUENT start up process and establishing a final

connection (e.g., to spawn parallel nodes, to checkout licenses, etc.), with a default

wait time of five minutes. You can change the waiting time increments for each step

by defining the FLUENT_WB_MAX_STARTUP_WAIT environment variable before

starting Workbench. Note that you cannot define this environment variable within

FLUENT Launcher. The value of this environment variable is equivalent to the wait

time in minutes for each start up step. So, the overall wait time is double the value

specified for the environment variable. Fractions are allowed as values for the envir-

onment variable, and any value less than or equal to zero will let Workbench wait

indefinitely for FLUENT to start. Note that while Workbench is waiting for FLUENT to

start, the Workbench interface is locked, and if, for some reason FLUENT fails to start,

you will have to manually kill the Workbench session.

If PBS Pro is selected as the job scheduler, the following additional property is available (on Linux

only):

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.14

Chapter 1: Getting Started With FLUENT in Workbench



PBS Submission Host

(optional) allows you to specify the name of the PBS Pro submission host if the machine you are

using to run Workbench cannot submit a job to PBS Pro.

These properties are the same as the settings within FLUENT Launcher. For more information about

FLUENT Launcher, see the FLUENT User's Guide.

In addition, note that the Solution cell contains additional general properties and some specific prop-

erties related to the solution process:

• General

– Component ID: the name of the cell (not editable).

– Directory Name: the name of the directory (“FFF”) where solution files are located (not editable).

– Use Setup Launcher Settings: enable or disable the use of the Setup cell's FLUENT Launcher

settings (see above).

• Solution Process

– Update Option: enables the solution process to be either Run in Foreground (solutions are

run within the current Workbench session), Run in Background (solutions are run in the

background on the local machine), or Submit to Remote Solve Manager (solutions are run in

the background by submitting the solution to Remote Solve Manager (RSM)). For more inform-

ation about these options and the Remote Solve Manager, please refer to Submitting Solutions

for Local, Background, and Remote Solve Manager (RSM) Processes in the ANSYS Workbench

User's Guide.

1.5.2.2. Copying FLUENT Launcher Property Settings

Typically, FLUENT Launcher settings are specified in the FLUENT Launcher dialog box when FLUENTis

launched from the Setup cell.

By default, the Solution cell uses the same FLUENT Launcher property settings as the Setup cell. If you

want the Solution cell’s FLUENT Launcher settings to be different than those specified for the Setup

cell, you can disable the Use Setup Launcher Settings property setting (see Specifying FLUENT

Launcher Settings Within Workbench (p. 9)) and then set the Solution cell’s FLUENT Launcher property

settings without impacting the settings for the Setup cell.

You can copy the Setup cell’s FLUENT Launcher settings to the Solution cell by selecting the Copy

Launcher settings to Solution cell option from the Setup cell’s context menu (available only when

the Use Setup Launcher Settings property setting is disabled). Note that the values that are written

are retained, even if you later disable this setting. Likewise, you can also copy the Solution cell’s FLUENT

Launcher settings to the Setup cell by selecting the Copy Launcher settings to Setup cell option from

the Solution cell’s context menu (available only when the Use Setup Launcher Settings property

setting is disabled).

1.6. Saving Your Work in FLUENT with Workbench

Data that is read into and written by FLUENT when it is run within Workbench is split into two parts:

• Setup data

• Solution data
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Setup data is the data used to start a simulation over from the beginning. This data is associated with

the Setup cell and includes the mesh (.msh ) file and the settings (.set ) file.

Important

The settings file is a file used when FLUENT is run under Workbench. It contains the case

settings but does not contain mesh data. The settings file and the mesh file are read by

FLUENT whenever FLUENT is launched from the Setup cell.

Important

Note that sometimes, instead of a mesh file, a case file (.cas ) is used to represent the mesh.

In this situation, FLUENT reads the case file first and then reads the settings file if it exists.

Therefore, the settings stored in the settings file will overwrite any settings that might be

contained in the case file.

Solution data is the data that results from performing a calculation and is used to restart a simulation

from existing data. This data is associated with the Solution cell and includes the current case (.cas )

file and the current data (.dat ) file.

Important

The case file and the data file are read by FLUENT whenever FLUENT is launched from the

Solution cell.

When working in Workbench, your work in FLUENT is automatically saved as needed. For example,

whenever you close FLUENT or save your Workbench project, your unsaved data is automatically saved.

You can save your Workbench project directly from FLUENT in two ways:

1. Select the Save Project option under the File menu within FLUENT.

File → Save Project

2. Select the Save Project option from the Write a File icon in the FLUENT toolbar.

Alternatively, you can also save your Workbench project by selecting the Save option under the File

menu within Workbench or by selecting the Save icon from the Workbench toolbar.

1.7. Exiting FLUENT and Workbench

You can end your FLUENT session by using the Close FLUENT option under the File menu.

File → Close FLUENT

You can end your Workbench session by using the Exit option under the File menu.

File → Exit

All open applications that are associated with your Workbench session, including any open instances

of ANSYS FLUENT, are automatically closed upon exiting Workbench. If there is any unsaved data in

Workbench or any of the open applications associated with your Workbench session, you will be

prompted to save your project before exiting Workbench.
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Important

There are several other circumstances in which open instances of FLUENT as well as other

applications are automatically closed:

• Whenever you close the current project in Workbench, all open applications are auto-

matically closed.

• Whenever you open a different project in ANSYS Workbench, all open applications asso-

ciated with the original project are automatically closed.

• Whenever a system is deleted, all open applications associated with that system are

automatically closed.

• Whenever data is reset or cleared from a cell, all open applications associated with that

cell are automatically closed.

1.8. An Example of a FLUENT Analysis in Workbench

This example describes when the files that are generated and used by FLUENT are written and how the

cell states change as you work with a FLUENT-based system in Workbench.

1. Add a new Fluid Flow (FLUENT) analysis system to the Project Schematic. The state of the Geometry

cell is Attention Required and that the states for the Mesh, Setup, Solution, and Results cells are

Unfulfilled.

2. Import a geometry file by using the context menu on the Geometry cell. The state of the Geometry

cell becomes Up-to-Date and the state of the Mesh cell becomes Refresh Required.
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3. Double-click the Mesh cell. The ANSYS Meshing application launches and loads the geometry file. The

state of the Mesh cell becomes Update Required.

4. In the ANSYS Meshing application, specify settings for the mesh, then select the Update command.

The mesh is generated, the mesh (.msh ) file is written, the state of the Mesh cell becomes Up-to-

Date, and the state of the Setup cell becomes Refresh Required.

5. Double-click the Setup cell. FLUENT launches and loads the mesh file. The state of the Setup cell be-

comes Attention Required.

6. In FLUENT, specify boundary conditions, initialize the solution, and enter a non-zero number of iterations

on the Run Calculation task page. The state of the Setup cell becomes Up-to-Date, and the state of

the Solution cell becomes Refresh Required.
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7. In the FLUENT application, select the Calculate button. The settings (.set ) file is written and iterations

begin. The state of the Solution cell becomes Update Required.

Iterations are completed, or the solution meets the convergence criteria. The state of the Solution

cell becomes Up-to-Date and the state of the Results cell becomes Refresh Required.

8. Double-click the Results cell. CFD-Post launches.

The case (.cas ) and data (.dat ) files are written, CFD-Post loads the case and data files, and the

state of the Results cell becomes Up-to-Date.
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1.9. Getting Help for FLUENT in Workbench

Workbench offers three levels of help:

• Quick help - available for most cells in a system. Click the blue triangle in the bottom right corner of

the cell to see a brief help description on that cell. For FLUENT-based systems, FLUENT-specific quick

help is available for the Setup and Solution cells, providing you with instructions for proceeding further.

For example:
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• Sidebar or context-sensitive help - available at any time by clicking F1.

• Online help - available from the Help menu, or from any of the links in the quick help or sidebar help.

For more information about Workbench help, see the on-line documentation.

FLUENT documentation and help is available from the FLUENT menu once the FLUENT application is

running. The documentation is automatically installed when you install Workbench.
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Chapter 2: Working With FLUENT in Workbench

This chapter provides instructions for using FLUENT in Workbench.

2.1. Importing Mesh, Case, and Data Files

2.2. Using the Update Command

2.3. Refreshing FLUENT Input Data

2.4. Deleting Solution and Setup Cell Data for FLUENT-Based Systems

2.5. Interrupting, Restarting, and Continuing a Calculation

2.6. Connecting Systems in Workbench

2.7. Duplicating FLUENT-Based Systems

2.8. Reviewing Mesh Manipulation Operations in FLUENT

2.9. Changing the Settings and Mesh in FLUENT

2.10. Case Modification Strategies with FLUENT and Workbench

2.11.Working With Input and Output Parameters in Workbench

2.12.Viewing Your FLUENT Data Using ANSYS CFD-Post

2.13. Understanding the File Structure for FLUENT in Workbench

2.14.Working with ANSYS Licensing

2.15. Using FLUENT With the Remote Solve Manager (RSM)

2.16. Using Custom Systems

2.17. Using Journaling and Scripting with FLUENT in Workbench

2.18. Performing System Coupling Simulations Using FLUENT in Workbench

2.19. Performing FLUENT and Ansoft Coupling in Workbench

2.1. Importing Mesh, Case, and Data Files

You can directly import a FLUENT case or mesh file into a FLUENT-based system by right-clicking on

the Setup cell and selecting the Import FLUENT Case... option from the context menu. You will be

prompted for a specific case or mesh file. After you select a file, FLUENT launches and loads the file you

specified. If you import a case file, the physical model settings, boundary condition information, mater-

ial properties and solver settings are also loaded into FLUENT.

When you import a case file in which the number of iterations (or time-steps) specified in the Run

Calculation task page is greater than 0, the state of the Setup cell becomes Up-to-Date and the state

of the Solution cell becomes Refresh Required.

When you import a mesh file or a case file in which the number of iterations (or time-steps) specified

in the Run Calculation task page is 0, the state of the Setup cell becomes Attention Required because

additional information must be specified in FLUENT before you can proceed.

If you import a case or mesh file into a system that contains a Mesh cell, you are informed that the

imported information will not be compatible with the information coming from the Mesh cell and asked

whether the Mesh cell (and Geometry cell, if it also exists) should be deleted and replaced by the mesh

from the imported file.

If you import a case or mesh file into a system that has a connection to a Mesh cell in an upstream

system, you are informed that the mesh is being provided to the current system from an upstream
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system and asked whether the connection should be deleted and the mesh replaced with the mesh

from the imported file.

Important

If a case or mesh file is imported into a Setup cell that already has settings information as-

sociated with it, the settings information is deleted when the new file is imported.

You can also directly import a FLUENT data file into a FLUENT-based system by right-clicking on the

Solution cell and selecting the Import Initial Data... option from the context menu. You will be

prompted for a data file. Importing a data file does not affect the state of the system. This option is not

available if FLUENT is already open or an incoming connection is providing data.

In addition, you can directly import a FLUENT data set (e.g., legacy FLUENT data, or a large data set

solved on an external cluster) into a FLUENT-based system by right-clicking on the Solution cell and

selecting the Import Final Data... option from the context menu. You will be prompted for a data file.

Importing a data file in this manner causes the Solution cell to be Up-to-Date, and allows you to import

data directly into a FLUENT-based system without the need to perform any additional solution tasks in

Workbench, i.e., you can immediately perform any post-processing of the data using ANSYS CFD-Post,

or you can directly transfer that data to another system (e.g., to perform one-way fluid-structure inter-

action (FSI) analysis). Note that after the state of the Solution cell is marked as Up-to-Date, then this

option is no longer available. This option is also not available if FLUENT is already open or an incoming

connection is providing data.

Important

For unsteady cases, if the last time-step data file is imported as a final data set, then

ANSYS CFD-Post can load all the previous time-step data as well, provided:

• All the previous time-step related (case/data) files are kept at same location as that

of final data, and that they have the same base file name as the last data file (as-

suming that the case file also has a consistent base file name).

• ANSYS CFD-Post directly reads this information from the data file. The FLUENT-based

system's Solution cell will not extract any of the solution history and further calcu-

lation will result in loss of this information. Note that performing additional calcula-

tions will change the solution history but it does not effect the data that is loaded

into ANSYS CFD-Post if the additional data is output with the same base file name

as the imported data file.

• Because of this reason, only the case/data file pairs originally generated by FLUENT

can be imported in Setup cell or the Solution cell as final case/data pairs.

– If the case file imported into the Setup cell is not same (at least the name) as

that of original case file, ANSYS CFD-Post will not be able to load the data.

– If you want to import a pair of case/data files with a different name, then you

need to perform at least one iteration in FLUENT in Workbench, automatically

saving this new set of data once FLUENT is closed or the Workbench is saved.

Alternatively, you can manually rename the case/data file sets to have the same

base file name prior to importing the final data set.
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Important

Final data files that are the result of calculations performed in FLUENT contain information

related to solution history. This solution history information is not retained if FLUENT imports

the data file as its final data, or if further calculations are later performed in FLUENT (even

though ANSYS CFD-Post will still be able to read the solution history information from the

imported data file).

For example, for an unsteady problem, if you calculate five solution points (test-1.cas ,

test-1.dat , ... etc.) using standard FLUENT (outside of Workbench), the entire solution

would be available in the solution history (i.e., any solution point can be read by FLUENT

using the Solution Files option under the File menu). In addition, all the solution points are

also available to ANSYS CFD-Post, for post-processing. If you subsequently run FLUENT in

Workbench and import the last case and data set (e.g., test-5.cas  and test-5.dat )

from the Solution cell as the final data, then only the imported data set is available in FLU-

ENT's solution history, however, ANSYS CFD-Post still has access to all of the solution history

(as long as the other solution files are contained in the same directory as the imported data

file). After importing the final data set, if you continue calculations, then the solution history

of the imported data file (i.e., test-1.cas , test-1.dat ...test-4.cas , test-4.dat ).

is no longer available to ANSYS CFD-Post.

Note

It should be noted that only FLUENT data files (.dat or .dat.gz ) are registered as part

of FLUENT solution history. A FLUENT data file can have additional data quantities (chosen

by you) stored in it along with other standard quantities.

When case and “initial” data files are imported into FLUENT, they are treated as start-up files and not

results files. Therefore, when you import a case and data file from a previous calculation, the state of

the Solution cell becomes Refresh Required and not Up-to-Date.

Important

In order to post-process the results from an existing set of case and “initial” data files in

ANSYS CFD-Post, at least one iteration (or time-step) must be performed in FLUENT from

within Workbench in order to bring the state of the Solution cell to Up-to-Date. Alternatively,

if you do not intend to perform any calculations, you could create a Results component

system, double-click its Results cell to open ANSYS CFD-Post and then load the FLUENT data

file using the Load Results option under the File menu in ANSYS CFD-Post.

Alternatively, you can also import pre-existing mesh, case, and data files from within FLUENT by using

one of the following options:

File → Import → Case...

File → Import → Data...

File → Import → Case and Data...

When mesh, case, and data files are imported from within FLUENT using these commands, the behavior

is exactly the same as when files are imported from the Project Schematic.
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In addition, you can also import the mesh from pre-existing mesh and case files from within FLUENT by

using the following option:

File → Import → Mesh...

When using this command, you are given two options:

Discard Case, Read New Mesh

- this discards any settings information currently in FLUENT and imports the specified file. If the specified

file is a case file, the settings information from that case file is also imported.

Replace Mesh

- this preserves the settings information currently in FLUENT and imports only the mesh from the specified

file.

2.2. Using the Update Command

The Update command is available from the context menu of all cells, from the context menu for the

system, and from the Workbench Toolbar, the Workbench  Tools menu, and the context menu for the

Project Schematic.

When selected from a cell, the Update command updates the current cell and all upstream cells that

must be updated to bring the current cell Up-to-Date. When a cell is updated, any new upstream data

is passed to it before performing the update command.

When selected from the system, the Update command updates all of the out-of-date cells in the current

system, as well as any cells in upstream systems that must be updated to bring the current system Up-

to-Date.

When selected from the Workbench Toolbar, the Workbench  Tools menu, or the context menu for the

Project Schematic, the Update command updates all out-of-date cells in the project.

When updating the Solution cell in a FLUENT system, the following steps take place:

1. FLUENT launches in the background.

2. FLUENT performs either the number of iterations (or time-steps) specified in the settings or case file

or the number of iterations required to reach convergence.

3. FLUENT writes the case and data files.

4. FLUENT exits.

Important

When an update is performed on a Solution cell and a FLUENT session from the same system

as that Solution cell is open, the calculation will be performed in that open FLUENT session.

This may not result in the action that you intended, therefore it is recommended that you

close any open FLUENT sessions before executing an Update command. For example, if you

have specified initial data using either a connection from an upstream solution cell or by

importing initial data into the Solution cell and you open FLUENT from the Setup cell of

the system, the initial data is not loaded (see Starting FLUENT from a FLUENT-Based Sys-

tem (p. 9)). If you subsequently perform an Update, the calculation will be performed in

the open FLUENT session and the initial data you specified will not be used as the starting

point.
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The Update command is particularly useful when you make changes to upstream data that impact

downstream data. For example, if you start with an Up-to-Date Fluid Flow (FLUENT) analysis system

and then modify the mesh in the ANSYS Meshing application, you can simply select Update from the

system’s context menu to generate the new results.

When performing an Update, you can specify whether the Solution cell in a FLUENT-based system

should be updated starting from the current data file or from the initial data. This is specified by selecting

or deselecting the Update from Current Solution Data if Possible option from the context menu of

the Solution cell. This option is enabled when there is a check mark to its left. This option is always

enabled by default.

The Update from Current Solution Data if Possible option for the Solution cell in a FLUENT-based

system will always have the highest priority. Here, the 'current solution data' refers to the updated

solution of the first design point (DP0) or the most recently computed design point, according to the

design point update order (option 1 below) as follows:

Currently, the following options are available:

1. Using the Parameter Set property view in Workbench (Design Point Update Order):

• Update from Current, or

• Update Design Points in Order

2. Using the options from the Solution cell context menu in the FLUENT-based system:

• If the Update from Current Solution Data if Possible option is enabled (true), then:

– In this case, the setting for the Parameter Set property Update Design Points in Order (if

specified) will be ignored.

– In this case, if the Solution cell has an upstream connection, then it will be ignored for all

design points, except the initial design point, DP0

• If the Update from Current Solution Data if Possible option is disabled (false), then:

– In this case, the setting for the Parameter Set property Update from Current (if specified) will

be ignored, and the initial data file (or upstream data file) or basic initialization will be used.

Initial data can be specified in four ways:

• On the Solution Initialization task page in FLUENT.

• Import an initial data file into the Solution cell or the FLUENT application (see Importing Mesh, Case,

and Data Files (p. 23)).

• Create a connection from an upstream Solution cell (see Connecting Systems in Workbench (p. 33)).

• Specify a case modification strategy (see Case Modification Strategies with FLUENT and Workbench (p. 50)).

If you have imported an initial data file or created a connection to specify initial data, that data will

override the initialization method specified on the Solution Initialization task page. If you have a case

modification strategy defined, the initialization step in that strategy will always be performed regardless

of whether initial data is specified in any other way.
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Important

If the Solution cell in a FLUENT-based system is connected to the Solution cell in an upstream

system, the Import Initial Data... option is not available from the context menu of the

downstream Solution cell. If you want to import initial data into the downstream Solution

cell, you must delete the connection first. Similarly, if the Solution cell already has imported

initial data, a connection cannot be made to that cell from the Solution cell in an upstream

system. Furthermore, you cannot create a connection from the Solution cell in an upstream

system to any Solution cell in which you have ever imported initial data.

Important

When you select Update from the Setup cell in a FLUENT-based system and a FLUENT session

is not already open, a FLUENT session launches in background mode. After the Update is

complete, the background session of FLUENT remains open and waits for you to update the

Solution cell. To close the open background session of FLUENT without updating the Solution

cell, you can select the Close FLUENT Session option from the Setup cell’s context menu.

Important

There is also an Update command in the ANSYS Meshing application which generates the

mesh and creates the input files required by downstream cells. The Generate Mesh command

in the ANSYS Meshing application generates the mesh but does not produce any input files.

If a connection is made from an up-to-date Mesh cell, the state of the Mesh cell may become

Update Required, indicating that the ANSYS Meshing application needs to generate an ad-

ditional input file. This file can be generated by selecting the Update option from the context

menu of the Mesh cell. If you try to open FLUENT before the Mesh cell is updated, a warning

message is displayed informing you that you must update the Mesh cell before you can start

FLUENT, since the mesh file required for FLUENT does not yet exist.

Important

Whether you edit the project through the Setup or Solution cells, your project’s post-pro-

cessing settings in FLUENT (including any surface definitions that you may have created), are

saved at the start of iteration or when you close FLUENT. When FLUENT is later opened from

either cell, these new settings will be available. Changes made to post-processing settings

in FLUENT do not affect cell state.

2.3. Refreshing FLUENT Input Data

You can refresh the input data for a cell by right-clicking on the cell and selecting the Refresh option

from the context menu. The Refresh command passes modified upstream data to the cell but does not

conduct any long-running operations to regenerate the cell’s output data.

For example, you can refresh the mesh by right-clicking on the Setup cell in Workbench and selecting

the Refresh option from the context menu. The state of the Setup cell becomes Update Required. It

will become Up-to-Date the next time you launch FLUENT from the Setup cell, or if you select the

Update option from the context menu of the Setup cell.
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You can refresh the input data for the Setup cell in a FLUENT-based system by using either the Refresh

command from the cell’s context menu or by selecting the Refresh Input Data option in the FLUENT 

File menu if FLUENT is already open.

Important

Selecting the Update option from the context menu performs a Refresh command (if needed)

before performing the Update command. You do not need to perform a Refresh and an

Update in two separate steps.

Important

If you open FLUENT after making a modification to the mesh and without refreshing the input

data, you will be asked whether you want to load the modified mesh before FLUENT launches.

Important

If FLUENT is open and you make a modification to the mesh, you will be informed that the

upstream mesh has changed and asked whether you want to load the new mesh before

proceeding.

2.4. Deleting Solution and Setup Cell Data for FLUENT-Based Systems

The following sections describes how to delete solution and setup data for your FLUENT-based systems

by using the Clear Generated Data command, the Reset command, and the Clear Old Solution Data

command.

2.4.1. Using the Clear Generated Data Command from the Solution Cell of FLUENT-Based Systems

2.4.2. Using the Reset Command from the Setup and Solution Cells of FLUENT-Based Systems

2.4.3. Using the Clear Old Solution Data Command from the Solution Cells of FLUENT-Based Systems

2.4.1. Using the Clear Generated Data Command from the Solution Cell of

FLUENT-Based Systems

For either type of FLUENT-based system, you can remove all past and current generated case and data

files from a Solution cell by right-clicking on the Solution cell and selecting the Clear Generated Data

option from the context menu. All past and current generated case and data files associated with the

cell are deleted and the FLUENT application is closed if it is open. If the Solution cell is Up-to-Date, it

will become Update Required when the Clear Generated Data command is executed.

2.4.2. Using the Reset Command from the Setup and Solution Cells of FLUENT-

Based Systems

For either type of FLUENT-based systems, you can remove all local and generated data from the Setup

cell or from the Solution cell by right-clicking on either cell and selecting the Reset option from the

context menu.

For Setup cells, the Reset option removes the Setup cell’s references to the mesh file, deletes the settings

file associated with the Setup cell, sets the cell property values to their defaults, and closes the FLU-

ENT application if it is open. If the Setup cell is Up-to-Date, it will become Refresh Required when the

Reset command is executed.
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For Solution cells, the Reset option deletes all past and current case and data files (not including im-

ported initial data files) associated with the cell, sets the cell property values to their defaults, and closes

the FLUENT application if it is open. If the Solution cell is Up-to-Date, it will become Refresh Required

when the Reset command is executed.

2.4.3. Using the Clear Old Solution Data Command from the Solution Cells of

FLUENT-Based Systems

For either type of FLUENT-based systems, you can remove all older local and generated data from the

Solution cell by right-clicking on the cell and selecting the Clear Old Solution option from the context

menu.

For Solution cells, the Clear Old Solution Data option retains only the most recent solution files asso-

ciated with the Solution cell, and removes older case and data files that are not part of the current

solution history. This option is only available if there are already solutions associated with the cell, in

addition to the most recent solution.

Note

Archived projects will only contain the most current solution files, and all solution files that

are associated with the current run (i.e., solution history).

Note

While importing design points, the next design point (dp1 ) will contain only the last data

file of the current solution from the last design point (dp0 ).

2.5. Interrupting, Restarting, and Continuing a Calculation

You can interrupt the calculation in an interactive FLUENT session by using the Cancel button or by

typing Ctrl and c at the same time in the FLUENT console window.

You can also interrupt a FLUENT calculation in the background by using the Progress Monitor in Work-

bench. The Progress Monitor is useful if you would like some visual feedback on the progress of your

calculations. Typically, the Progress Monitor is hidden, but can be displayed at the bottom of the Project

Schematic by toggling the Show Progress button.
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Figure 2.1  The Show Progress Button in Workbench

When the Progress Monitor is displayed, the Show Progress button becomes the Hide Progress button,

so the button can be used to toggle the display of the Progress Monitor.
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Figure 2.2  The Hide Progress Button, the Progress Monitor and the Stop Icon in Workbench

To interrupt an on-going FLUENT calculation from Workbench, select the  icon in the Progress

Monitor (see Figure 2.2 (p. 32)). This will display a prompt, asking if you would like to interrupt or stop

the calculations.
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Figure 2.3  The Workbench Prompt

Selecting Interrupt stops the calculation at the next point where data can be safely stored for later

use. Selecting Stop stops the calculation immediately without concern for whether data associated with

the current action can be stored.

Important

When the calculation is interrupted from within an interactive FLUENT session, it always stops

the data at the next point where data can be safely stored for later use.

When a calculation is interrupted, the state of the Solution cell becomes Interrupted. If a background

calculation is interrupted, FLUENT writes the case and data file and then closes.

You can restart a previously interrupted FLUENT calculation from within Workbench by right-clicking

on the Solution cell and selecting the Continue Calculation option from the context menu. This will

allow you to restart the calculation from the current case and data files, performing the total number

of iterations (or time-steps) specified in the case file.

If you interrupt a calculation, review the results, and decide that the solution is converged, you can

force the Solution cell state to be Up-to-Date by right-clicking on the Solution cell and selecting the

Accept Interrupted Solution as Up-to-Date option from the context menu.

2.6. Connecting Systems in Workbench

Workbench allows you to create connections between multiple systems that enable the systems to access

the same data. This is useful, for instance, when you want to compare the results from multiple FLUENT-

based systems in the same ANSYS CFD-Post session. In this case, you would connect the various Solution

cells to one Results cell (either in one of your FLUENT-based systems or in a separate Results system).

When you double-click on that Results cell, the results from all connected systems will be loaded into

ANSYS CFD-Post at the same time.

Workbench supports two different types of connections:

• Connections that share data are used when the inputs and outputs of the two connected cells are

identical. Shared data connections can only be created between two cells of the same type. A shared

data connection is represented on the Project Schematic by a line with a square on its right (target)

side (see Figure 2.4 (p. 35)).

• Connections that transfer data are used when the output of one cell is used as the input to the connected

cell. Transfer data connections are usually created between two cells of different types. One exception

is that a transfer data connection can be used between the Solution cells of two FLUENT-based systems

when you want to use the current data from one system as the initial data for the other system. A
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transfer data connection is represented in the Project Schematic by a line with a circle on its right (target)

side (see Figure 2.4 (p. 35)).

There are four ways to create connected systems in Workbench.

• Left-click a cell in one system, then drag and drop it onto a compatible cell in another system.

• Left-click a system in the Toolbox, then drag and drop it onto a compatible system in the Project

Schematic.

• Create a duplicate system (see Duplicating FLUENT-Based Systems (p. 40)).

• Right-click on a cell and select one of the options under Transfer Data From New... or Transfer Data

To New... (these options are not available for all cells). Transferring data from the Solution cell to a

new FLUENT system's Setup cell transfers the mesh (but not the settings) to the Setup cell.

When you highlight a system in the Toolbox, Workbench highlights all of the compatible drop targets

in the Project Schematic. As you move the mouse over a drop target, it is highlighted in red and a

message appears in the Project Schematic that informs you what the result will be if you drop the system

onto that target.

Important

There are usually several compatible drop targets on empty space in the Project Schematic.

Dropping the system onto one of these targets will create a standalone system in that location.

Similarly, when you highlight a cell and begin to drag it, Workbench highlights all of the compatible

drop targets in the Project Schematic. As you move the mouse over a drop target, it is highlighted in

red and a message appears in the Project Schematic that informs you what the result will be if you

drop the cell onto that target.
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Figure 2.4  Connected Systems Within Workbench

For more information about connecting systems, see the Workbench on-line help, as well as the following

sections:

2.6.1. Connecting Systems by Dragging and Dropping a System from the Toolbox onto Another System

2.6.2. Connecting Systems By Dragging and Dropping FLUENT-Based Solution Cells Onto Other Systems

2.6.1. Connecting Systems by Dragging and Dropping a System from the

Toolbox onto Another System

The following example demonstrates the procedure for creating connected systems by dragging a

system from the Toolbox and dropping it onto a compatible system in the Project Schematic.

1. Starting from a project with an up-to-date Mesh component system, select the FLUENT-based com-

ponent system from the Toolbox; the compatible drop targets are highlighted in green.

2. Drag the system over the Project Schematic and pause over the Mesh cell of the Mesh component

system; the Mesh cell target is highlighted in red and a message informs you that selecting that target

will transfer the data from cell A3 to the new system.

3. Drop the system on the drop target and a transfer data connection is created between the Mesh cell

A3 and the Setup cell B1.
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Note that Mesh cell A3 becomes Update Required, this is because the input data for the new

system has not yet been generated by the ANSYS Meshing application.

Important

If you try to open FLUENT before the Mesh cell is updated, a warning message is dis-

played informing you that you must update the Mesh cell before you can start FLUENT,

since the mesh file required for FLUENT does not yet exist.

4. Right-click Mesh cell A3 and select Update.

5. Double-click Setup cell B1; FLUENT launches and loads the mesh from cell A3.

Figure 2.5  Applying the Mesh Settings to a New FLUENT-Based Component System by

Dragging and Dropping Systems
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In the previous example, a transfer data connection was created. Shared data connections can also be

creating by dragging a system from the Toolbox and dropping it onto a compatible system in the Project

Schematic. The type of connection that Workbench creates depends on which drop target you select.

The red preview messages in the Project Schematic inform you of the type of connection(s) that will

result from your action.

When a FLUENT-based component system is dragged from the Toolbox onto the Solution cell of an

existing FLUENT-based analysis system, you are presented with two choices: Transfer Solution Data

or Transfer Mesh Data. The connection that is made between the two systems is based on the option

selected.

Figure 2.6  Transferring Solution Data or Mesh Data to a New FLUENT-Based Component

System by Dragging and Dropping Systems
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Important

The mesh from the case file associated with the Solution cell of a FLUENT-based analysis

system or component system can be transferred to the Setup cell of a FLUENT-based com-

ponent system only and not the Setup cell of a FLUENT-based analysis system.

2.6.2. Connecting Systems By Dragging and Dropping FLUENT-Based Solution

Cells Onto Other Systems

The following figures demonstrate the procedure for creating a transfer data connection by dragging

a Solution cell from a FLUENT-based system and dropping it onto a compatible cell in another system:

Figure 2.7  An Example of Two Unconnected Systems

Figure 2.8  An Example of Dragging and Dropping a Solution Cell Onto Another Compatible

Cell
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Figure 2.9  An Example of Two Connected Systems

The following table lists the compatible drop targets for the Solution cell from a FLUENT-based system:

Table 2.1  Connecting Systems By Dragging and Dropping Cells Between Systems

To CellFrom Cell

FLUENT: SetupSolution

FLUENT: Solution

Fluid Flow (FLUENT): Solution

Fluid Flow (FLUENT): Results

CFX: Results

Fluid Flow (CFX): Results

Vista TF: Results

Results: Results

Static Structural (ABAQUS):

Setup

Static Structural (Samcef ): Setup

Shape Optimization (ANSYS):

Setup

Static Structural: Setup

Steady-State Thermal: Setup

Transient Structural: Setup

Thermal-Electric: Setup

Transient Thermal: Setup
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2.7. Duplicating FLUENT-Based Systems

Workbench allows you to create a duplicate of a system so that you can set up multiple, similar systems

and analyze them at the same time. For instance, if you would like to study the differences in the fluid

flow between two slightly different geometries, then you can create, set up, and solve a single fluid

flow analysis system, duplicate the entire system, change the geometry in the duplicate system and

perform another fluid flow analysis on the new geometry.

You can create a duplicate of a FLUENT-based system by performing the following steps:

1. In the Project Schematic, right-click the system header to open the system’s context menu.

2. Select Duplicate from the context menu.

A copy of the original FLUENT-based system is created in the Project Schematic.

All data associated with the FLUENT-based system, except for any case, data, and initial data files asso-

ciated with the Solution cell, are copied to the new system. The states of the Geometry, Mesh, and

Setup cells in the new system will be the same as the states of the cells in the original system. The

state of the Solution and Results cells in the new system will be different than those of the original

system if the original system had case and data files associated with its Solution cell.

In addition, you can use the Duplicate command to create a duplicate of a FLUENT-based system in

which the data in the Geometry cells or the data in both the Geometry cells and the Mesh cells is

shared between the two systems rather than copied.

To create a duplicate system in which the geometry is shared between the original and new system:

1. In the Project Schematic, right-click the Mesh cell in the system you want to duplicate to open the

context menu.

2. Select Duplicate from the context menu.

A copy of the original FLUENT-based fluid flow system is created in the Project Schematic. A shared

data connection is created between the Geometry cell in the original system and the Geometry

cell in the new system.

To create a duplicate system in which both the geometry and the mesh are shared between the original

and new system:

1. In the Project Schematic, right-click the Setup cell or any cell below it in the system you want to du-

plicate to open the context menu.

2. Select Duplicate from the context menu.

A copy of the original FLUENT-based fluid flow system is created in the Project Schematic. Two

shared data connections are created: one between the Geometry cell in the original system and

the Geometry cell in the new system, and the other between the Mesh cell in the original system

and the Mesh cell in the new system.

2.8. Reviewing Mesh Manipulation Operations in FLUENT

While working within FLUENT in Workbench, you are able to perform and preserve basic mesh manip-

ulation operations in FLUENT. The mesh manipulation operations are saved as part of the Workbench

project in the Setup cell such that the operations are explicitly applied by Workbench once FLUENT

loads the mesh (and before reading the settings file) and automatically reapplied the next time an
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Update is performed. This allows you to more easily update the system if the upstream mesh has

changed, and also, for example, when parameters are modified (see Changing the Settings and Mesh in

FLUENT (p. 45)).

You are able to perform and preserve the following mesh operations in FLUENT in Workbench:

• scaling

• rotation

• translation

• smoothing

• swapping

• merging

• fusing

• zone/domain renaming

• zone/domain reordering

• zone type changing (the final zone type is dependent on the settings file. This is recorded primarily

to address occasional mesh changes triggered by a change in the zone type)

• creating periodic zones

• polyhedra operations (convert to polyhedra, convert skewed cell to polyhedra)

Important

By contrast, the following mesh operations are not recorded within FLUENT in Workbench:

• separating faces and cells

• zone operations such as activating, deactivating, deleting, and replacing zones, as well as

appending case and data files

• replacing meshes

• adapting meshes, specifically using

– boundaries

– gradients

– iso-values

– regions

– Yplus/Ystar

– anisotropic

– volume

See Modifying the Mesh in the User's Guide for more information about manipulating the mesh in

FLUENT.

41
Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Reviewing Mesh Manipulation Operations in FLUENT



These common mesh manipulation operations can be reviewed while working with FLUENT in Workbench

using the Recorded Mesh Operations option in the Mesh menu.

Mesh → Recorded Mesh Operations...

This displays the Recorded Mesh Operations dialog box (Figure 2.10 (p. 42)).

When FLUENT is started from the Solution cell, the Recorded Mesh Operations option in the Mesh menu

is disabled.

Figure 2.10  The Recorded Mesh Operations Dialog Box

The Recorded Mesh Operations dialog box allows you to view the mesh manipulation operations that

are currently stored. You can also see new operations, or see if an operation has failed due to an incom-

patible upstream mesh. In the Recorded Mesh Operations dialog box, the following controls are

available:

• Reset — resets the stored mesh operations, clearing out all existing mesh operations, and accepting

the current zones as expected incoming zones.

• Delete — deletes the selected stored mesh operation.

• Reload — saves  only the current set of mesh operations and incoming zone information, and reloads

the Setup cell.

Note the Reset, Delete, and the Reload buttons are disabled when there are no mesh operations listed in

the Recorded Mesh Operations dialog box.

Important

You should note that using Reset/Delete/Reload is discouraged in cases with topological

mesh transformations because of potential mismatches between recorded operations and

the settings file.

In the Recorded Mesh Operations dialog box, select a listed operation to expand the dialog box in

order to review the details of the selected mesh operation. For example. Figure 2.11 (p. 43) illustrates

how you can review the details of the rotation operation upon a mesh.
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Figure 2.11  Reviewing the Details of Rotating the Mesh in the Recorded Mesh

Operations Dialog Box

For a selected operation, specific details about the mesh manipulation operation can be reviewed under

Operation Details in the Recorded Mesh Operations dialog box. Note that when rotating the mesh,

the angle is provided in radians, and when translating the mesh, the distance is provided in meters.

You can also view (and minimally edit) the names of incoming (i.e., upstream) zone names by clicking

the Edit Incoming Zones... button in the Recorded Mesh Operations dialog box. This displays the

Incoming Zones dialog box (Figure 2.12 (p. 43)).

Figure 2.12  The Incoming Zones Dialog Box
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Using the Incoming Zones dialog box, you can see new or missing zones, remove zones, or match

zone names. When FLUENT is closed, all of the zones shown in the Incoming Zones dialog box are in-

cluded in the list of zones that FLUENT expects in the upstream mesh. This list is used to provide you

with warnings about any new or missing zones. The stored mesh operations and settings will continue

to behave as expected depending upon what zones they are operating upon.

To correct any issues with missing or new incoming zone names, click the Match Zone Names... button

in the Incoming Zones dialog box to open the Match Zone Names dialog box.

Figure 2.13  The Match Zone Names Dialog Box

The Match Zone Names dialog box contains a listing of any missing zones or new zones in their re-

spective columns. Simply select a zone in the Missing Zones list and select a corresponding zone in

the New Zones list, and click Apply.

You can use the Match Zone Names dialog box to manually manage upstream topological changes

(such as zone name changes). For instance, if a zone name has changed upstream, you can use this

dialog box to match the corresponding zone names, effectively renaming the zone in FLUENT. In this

case, you should perform a Reload after renaming the old zone name, if you do not want to change

anything in the settings file. Another example would be if a zone is no longer present in the upstream

mesh, then you can delete it using the Incoming Zones dialog box. In this case, reloading would not

work since the settings file will also need to be written. So, you would delete the zone names that are

no longer expected and then continue setting other details, solving, and closing FLUENT as you would

normally do.

Important

After matching all zone names, it is recommended to use the Reload button in the Re-

corded Mesh Operations dialog box.
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Note

For older FLUENT in Workbench projects (prior to version 14.0), when making any changes

to the mesh using ANSYS Meshing (e.g., renaming a surface), you should first open FLUENT

using the Setup cell of the Fluid Flow (FLUENT) analysis system in order for FLUENT to be

aware of the upstream mesh changes (e.g., when detecting upstream zone name changes).

2.9. Changing the Settings and Mesh in FLUENT

In order to use the Update command (see Using the Update Command (p. 26)) when changes are made

to your project, FLUENT must know which settings changes should be stored as part of the Setup cell’s

data (and therefore used during an update) and which settings changes should only be reflected in the

results data that is associated with the Solution cell.

Important

Please note that there are certain changes to the mesh that you can perform within FLUENT

that are able to be recorded and reviewed and are treated as settings. In addition, there are

other changes to the mesh within FLUENT that are not recorded, and, as such, are not saved

as settings, and cannot be automatically re-applied when the Update command is used. For

more information about recording and reviewing mesh manipulation operations in FLUENT

in Workbench, see Reviewing Mesh Manipulation Operations in FLUENT (p. 40).

In order to address these issues, if you make certain changes to the mesh and/or settings in FLUENT,

you may be prompted when you attempt to calculate, close FLUENT, or save the project from FLUENT.

The dialog boxes that appear (described in more detail below) allow you to select an action or to cancel

the operation.

Important

If you save the project from an application other than FLUENT or from the Project Schematic,

you will not be prompted; FLUENT will automatically perform the default action for each

dialog box described below.

For more information, please see the following sections:

2.9.1. Changing Case and Mesh Settings Before Beginning a Calculation

2.9.2. Changing Case and Mesh Settings After a Calculation Has Started

2.9.1. Changing Case and Mesh Settings Before Beginning a Calculation

Important

Note that in the descriptions below, mesh changes performed within FLUENT only include

those mesh modifications that are not recorded in FLUENT in Workbench. In addition, changes

to the settings can also include any mesh modifications that can be recorded in FLUENT in

Workbench. For more information about recording and reviewing mesh manipulation oper-

ations in FLUENT in Workbench, see Reviewing Mesh Manipulation Operations in FLUENT (p. 40).

If the mesh has not been changed using tools in FLUENT, any changes to the settings are automatically

saved to the settings (.set ) file.
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If the mesh has been changed using tools in FLUENT and the mesh was imported into the FLUENT ap-

plication or the system’s Setup cell, any changes to the settings are automatically saved to the settings

(.set ) file. In addition, a case file is saved and registered to the Setup cell to represent the modified

mesh.

If the mesh has been changed using tools in FLUENT and the mesh was provided to the system’s Setup

cell by an upstream cell, the saved settings may not be compatible with the original mesh available to

the Setup cell.

Since the mesh was provided to the system’s Setup cell by an upstream cell, the original mesh cannot

be replaced by the modified mesh without also making changes to the Project Schematic. Since there

are several ways in which the schematic can be modified, FLUENT does not provide a way to do this

automatically.

Any changes to the settings will be saved to the settings file. The action you requested when you were

prompted will proceed. If you had selected to calculate, the iterations (or time-steps) will be performed

on the modified mesh. If you had selected to close FLUENT or save the project, the modified mesh will

be stored in the case file that is written as a result of either of those actions.

Important

If you open FLUENT from the Setup cell, or update or refresh the Setup or Solution cell

from the Project Schematic, the modified mesh will be replaced with the mesh provided by

the upstream cell. To calculate using the modified mesh, either open FLUENT from the

Solution cell or select Continue Calculation from the Solution cell’s context menu.

Important

If you specified settings before you changed the mesh, you must also verify that those settings

are consistent with the modified mesh.

Important

If you want to use the modified mesh as the starting point for another analysis, simply create

a new FLUENT-based system and import the new case file that contains the modified mesh

into its Setup cell.

You can avoid performing the mesh modification (which cannot be recorded by FLUENT) and create a

case modification strategy that automatically performs the desired mesh modification steps (as well as

any settings changes that are dependent on the modified mesh) before calculating (see Case Modification

Strategies with FLUENT and Workbench (p. 50)). This will allow you to automatically repeat the desired

mesh modifications every time you perform an Update or restart the calculation from the Setup cell.

Important

If you plan to make modifications to your mesh in FLUENT (such as scaling, rotating, or

converting to polyhedra) before performing any calculations, and you do not require any

change made upstream of the FLUENT  Setup cell to be propagated to the mesh in the future,

you should import the mesh you plan to modify directly into the Setup cell of a FLUENT-

based analysis or component system.
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2.9.2. Changing Case and Mesh Settings After a Calculation Has Started

Important

Note that in the descriptions below, mesh changes performed within FLUENT only include

those mesh modifications that are not recorded in FLUENT in Workbench. In addition, changes

to the settings can also include any mesh modifications that can be recorded in FLUENT in

Workbench. For more information about recording and reviewing mesh manipulation oper-

ations in FLUENT in Workbench, see Reviewing Mesh Manipulation Operations in FLUENT (p. 40).

If changes to the settings have been made and the mesh has not been changed using tools in FLUENT,

you are prompted with the following dialog box:

Figure 2.14  The Setup has changed! Dialog

Since changes were made to the settings after you began the calculation, you have to specify whether

or not the settings changes should be saved to the settings file.

You can choose any of the following actions:

• Select the Ignore Setup changes option in the warning dialog box. The modified settings will not be

saved to the settings file. The action you requested when you were prompted will proceed. If you had

selected to calculate, the iterations (or time-steps) will start using the new settings. If you had selected

to close FLUENT, or save the project, the new settings will be stored in the case file that is written as a

result of either of those actions.

Important

If you open FLUENT from the Setup cell, or update or refresh the Setup or Solution cell

from the Project Schematic, the settings will be replaced with the settings in the settings

file that is associated with the Setup cell. To calculate using the new settings either

open FLUENT from the Solution cell or select Continue Calculation from the Solution

cell’s context menu.

Important

If you want to use the new settings as the starting point for another analysis, simply

create a new FLUENT-based system and import the new case file that contains the new

settings into its Setup cell.

• Select the Save Setup changes option in the warning dialog box. The modified settings will be saved

to the settings file. The action you requested when you were prompted will proceed. If you had selected
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to calculate, the iterations (or time-steps) will start using the new settings. If you had selected to close

FLUENT, or save the project, the new settings will also be stored in the case file that is written as a

result of either of those actions.

• Select Cancel in the warning dialog box. Create a new duplicate system (see Duplicating FLUENT-Based

Systems (p. 40)), modify the settings, and connect the Solution cells for the two systems so that the

calculations will be performed in sequence.

• Select Cancel in the warning dialog box and create a case modification strategy that automatically

performs the desired settings changes after the appropriate number of iterations (or time-steps); see

Case Modification Strategies with FLUENT and Workbench (p. 50) for more details.

The last two approaches allow you to automatically repeat setting changes after a specified number of

iterations (or time-steps) every time you perform an Update or restart the calculation from the Setup

cell.

If the mesh has been changed using tools in FLUENT, and the mesh includes changes made using dy-

namic or sliding mesh), you are prompted with the following dialog box:

Figure 2.15  The Mesh and settings have changed! Dialog

Important

Note that when FLUENT modifies the mesh, FLUENT does not allow you to save the modified

settings and/or mesh operations once the calculation has started.

Otherwise, if the mesh has been changed using tools in FLUENT, you are prompted with the following

dialog box:

Figure 2.16  The Mesh and settings have changed! Dialog

You need to specify whether or not any changes you made to the settings after you began the calculation

should be saved to the settings file. Note that in cases where unrecorded mesh operations are performed

in FLUENT, those mesh operations will be ignored in future solution runs.
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Important

Whenever you modify the mesh in FLUENT, you also make changes to some settings in

FLUENT. Therefore, mesh modifications always result in setting changes.

Important

The original mesh cannot be replaced by the modified mesh after the calculation has begun.

You can choose any of the following actions:

• Select the Use settings and mesh changes for current calculations only option in the warning dialog

box. The modified settings will not be saved to the settings file. The action you requested when you

were prompted will proceed. If you had selected to calculate, the iterations (or time-steps) will start

using the new settings and the modified mesh. If you had selected to close FLUENT, or save the project,

the new settings and the modified mesh will be stored in the case file that is written as a result of either

of those actions.

Important

If you open FLUENT from the Setup cell, or update or refresh the Setup or Solution cell

from the Project Schematic, the settings and the modified mesh will be replaced with

the mesh and settings in the files that are associated with the Setup cell. To calculate

using the new settings and the modified mesh, either open FLUENT from the Solution

cell or select Continue Calculation from the Solution cell’s context menu.

Important

If you want to use the new settings and the modified mesh as the starting point for

another analysis, simply create a new FLUENT-based system and import the new case

file that contains the new settings and the modified mesh into its Setup cell.

• Select the Use settings and mesh changes for current and future calculations option in the warning

dialog box. The modified settings will be saved to the settings file. The action you requested when you

were prompted will proceed. If you had selected to calculate, the iterations (or time-steps) will start

using the new settings and the modified mesh. If you had selected to close FLUENT, or save the project,

the new settings and the modified mesh will also be stored in the case file that is written as a result of

either of those actions.

Important

If you open FLUENT from the Setup cell, or update or refresh the Setup or Solution cell

from the Project Schematic, the new settings will be used in conjunction with the mesh

in the file that is associated with the Setup cell. Since those settings may have been

specified after the mesh was modified, you must verify that the new settings are consist-

ent with the original mesh.

• Select Cancel in the warning dialog box and create a case modification strategy that automatically

performs the desired settings changes and mesh modification steps after the appropriate number of
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iterations (or time-steps); see Case Modification Strategies with FLUENT and Workbench (p. 50) for more

details. This allows you to automatically repeat the desired setting changes and mesh modification steps

after a specified number of iterations (or time-steps) every time you perform an Update or restart the

calculation from the Setup cell.

2.10. Case Modification Strategies with FLUENT and Workbench

FLUENT allows you to specify your own initialization and start-up routines using automatically executed

strategies that you can define using the Automatic Solution Initialization and Case Modification

option on the Calculation Activities task page within FLUENT. Selecting the option and clicking the

Edit.. button opens the Automatic Solution Initialization and Case Modification dialog box.

Figure 2.17  Accessing Solution Strategies in FLUENT

Using the Automatic Solution Initialization and Case Modification dialog box, you are able to specify

your initialization method on the Initialization Method tab and use any text user interface (TUI) com-

mand to modify the case after a specified number of time steps or iterations in the Case Modification

tab. This option replaces the need for some simple journal files, especially for cases where a prescribed

start-up and solution routine is used (start with 1st order, switch to 2nd order, turn on reactions, etc.)

When a case modification strategy is defined within FLUENT, it will be used when a system is updated

from the Project Schematic in Workbench.

As mentioned in Changing the Settings and Mesh in FLUENT (p. 45), mesh manipulations steps executed

from within FLUENT are not repeated when an update is performed from the Project Schematic or you

start FLUENT from the Setup cell. However, for mesh manipulation, you can specify steps that will be

executed at the beginning of your calculation if you incorporate them into a case modification strategy.

Solution strategies can also be useful when you need to perform mesh manipulation steps after a spe-

cified number of iterations during a calculation.
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Important

Whenever you run a case modification strategy interactively, make sure to reload the original

mesh and revert to the original settings before re-running the case modification strategy

(see the separate FLUENT User's Guide for information on how the original settings can be

reset automatically as part of a case modification strategy).

Important

When running FLUENT in Workbench, the behavior when continuing the calculation from

the Solution cell, when a solution strategy is defined, is different than when additional iter-

ations or time steps are specified in the Run Calculations task page. When a solution strategy

is defined, FLUENT will complete the iterations or time steps specified by the solution strategy.

Once the solution is Up-to-Date, continuing the calculation has no effect. On the other hand,

when additional iterations or time steps are specified in the Run Calculations task page,

every time you choose to continue the calculation, FLUENT will try to perform the specified

number of iterations or time-steps.

For more information about using these features in FLUENT, see the FLUENT User's Guide.

2.11. Working With Input and Output Parameters in Workbench

Workbench uses parameters and design points to allow you to run optimization and what-if scenarios.

You can define both input and output parameters in FLUENT that can be used in your Workbench project.

You can also define parameters in other applications including ANSYS DesignModeler and ANSYS CFD-

Post. Once you have defined parameters for your system, a Parameters cell is added to the system and

the Parameter Set bus bar is added to your project. Arrows representing input and output parameters

connect the bus bar to each system in which you have defined parameters.

Double-click the Parameter Set bus bar to open the Parameters workspace. The parameters workspace

includes the Outline of All Parameters table that lists all of the parameters in your project as well as

the Table of Design Points table in which you can specify design points.

To create a new design point, enter the input parameter values that you want to use for that design

point in the Table of Design Points in the row with an asterisk (*) in the first column. You can create

several design points. Once you have finished specifying design points, you can right-click the row for

one design point and select the Update Selected Design Point option from the context menu to

compute the output parameters for that design point. Alternatively, you can select Update All Design

Points from the Toolbar to update all of your design points in sequence.
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Important

Only the data from the design point in the row labeled Current is saved with the project. If

you want to post-process the results from a different design point in either ANSYS FLUENT or

ANSYS CFD-Post, click the box in the Exported column for that design point before you

update that design point. Otherwise, the data for that design point is automatically deleted

after the output parameters for that design point are updated. If you choose to export a

design point, the data associated with that design point is exported to a new project. The

new project is located in the same directory as the original project. The name of the project

is the same as the name of the original project, except that it is appended with _dpn , where

n is the row number that corresponds to the design point in the original project’s Table of

Design Points.

Important

Note that you cannot create, edit, delete, or rename parameters in FLUENT if any iterations

(or time-steps) have been performed. If you want to create, edit, delete, or rename parameters

in FLUENT for a case with an existing solution, you must first initialize the solution.

For more information about input and output parameters in FLUENT, see the FLUENT User's Guide.

For more information about parameters, design points, what-if scenarios and optimization studies in

Workbench, see the Workbench on-line documentation.

Note

Various ANSYS FLUENT setup—related input quantities (of type real and profile) can be as-

signed to an input parameter (indicated by the New Input Parameter... option in the cor-

responding drop-down list or by a small “p” icon next to the field). Clicking this option or

icon displays the Select Input Parameter dialog box (see Figure 2.18 (p. 53)) where you can

create and assign input parameters.
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Figure 2.18  The Select Input Parameter Dialog Box

The Select Input Parameters dialog box contains a list of existing compatible input parameters under

Parameters. The Current Value field contains the value of the currently selected parameter. The Used

In field lists any variables that are already associated with the currently selected parameter. You can

also change the associated parameter or switch it back to a constant (i.e., real) value using the Use

Constant button. Clicking the New Parameter button displays the Input Parameters Properties dialog

box (see Figure 2.19 (p. 53)) where you can define a new input parameter along with its value.

Figure 2.19  The Input Parameter Properties Dialog Box

The Input Parameters Properties dialog box allows you to enter a new Name and Current Value for

the input parameter, as well as to see any variables that may be associated with the parameter.
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Note

ANSYS FLUENT automatically creates generic default names for new input and output para-

meters (e.g., parameter-1 , parameter-2 , parameter-3 , etc.) If a parameter is deleted,

the default name is not reused. For example, if you have parameter-1 , parameter-2 ,

and parameter-3 , then delete parameter-2  and create a new parameter, the default

name for the new parameter will be parameter-4 .

2.12. Viewing Your FLUENT Data Using ANSYS CFD-Post

ANSYS CFD-Post is a post-processing application that helps you visualize the results of your ANSYS

FLUENT CFD simulations. For FLUENT-based analysis systems, the Results cell provides access to the

ANSYS CFD-Post application. In addition, the Toolbox contains a separate Results component system

(i.e., ANSYS CFD-Post) that you can add to the Project Schematic and connect to FLUENT-based systems.

When a Results cell is connected to a FLUENT-based system’s Solution cell and the Results cell’s state

is either Refresh Required or Update Changes Pending, you can view the results of your FLUENT cal-

culation in ANSYS CFD-Post by double-clicking the Results cell. This will load the FLUENT results into

ANSYS CFD-Post.

Figure 2.20  Multiple FLUENT Results Loaded Into ANSYS CFD-Post
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Important

In addition to analyzing your results in ANSYS CFD-Post, you can also view the results of your

simulation using the standard FLUENT postprocessing tools. For more information, see the

separate FLUENT User's Guide.

Important

There are two options for exporting FLUENT files for ANSYS CFD-Post:

1. Standard FLUENT case and data files do not contain all variables, however, you can add

additional quantities to your regular FLUENT data file using the Data File Quantities dialog

box in FLUENT.

2. Lightweight data files are created by exporting ANSYS CFD-Post compatible files. These files

can be used to save just the variables of interest.

When you edit a Results cell that is connected to the Solution cell in a FLUENT-based system,

ANSYS CFD-Post always loads the standard FLUENT case and data files. For more information

on exporting FLUENT files for ANSYS CFD-Post, see the separate FLUENT User's Guide.

2.13. Understanding the File Structure for FLUENT in Workbench

When you save a Workbench project (e.g., my-project ), the project is saved with a .wbpj  extension

(e.g., my-project.wbpj ). Other files associated with the project (through other Workbench applications

such as ANSYS FLUENT or CFX) are located in the dp0  folder within a _files  folder (e.g., my-pro-
ject_files ).

Each system in the Project Schematic has its own directory under the dp0  directory. The directory is

named using the corresponding system identifier (e.g., FFF represents a FLUENT-based analysis system;

FLU represents a FLUENT-based component system; Post  represents a Results component system,

etc.). The directory name is appended with a number to distinguish it from the directories for other

systems of the same type (with the exception of the directory name for the first system of a specific

type which has no number appended to it).

Within each system directory is a folder for each application that is part of the system. This folder is

used to store the files generated and used by the application.

In addition to the settings, case and data files, the following files are managed by FLUENT in Workbench:

• monitor files

• flamelet files

• view factor files

• non-premixed files (.pdf )

• interpreted user-defined (UDF) files

• compiled UDF libraries

• Discrete Transfer Radiation (DTRM) .ray  files

• mechanism files (.che  or .inp )

• property database files (thermo.db  and transport.db )
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You may use other types of files with FLUENT in Workbench, however, you are responsible for making

sure that they are located in the appropriate folder within the project file structure.

The following figure represents an example of the directory structure for Workbench project with two

Fluid Flow (FLUENT) systems and one Results system:

Figure 2.21  Example of the Directory Structure for a FLUENT-Based Project in Workbench

You can view the files associated with your Workbench project by selecting the Files option under the

View menu.

View → Files
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Figure 2.22  The Files View for a Project in Workbench

If data is shared between two systems, then files are also shared between the two systems. The shared

file will exist in either the directory of the first system that used it, or in a global directory in the design

point directory (depending on the type of system that generated the file).

The _files  folder also contains a user_files  directory. This directory should be used for any files

you create or reference that you would like to store with the project.

Important

In general, you should not modify the structure of the project directories or delete or modify

any of the files that Workbench applications have stored in the project directories. However,

you may delete FLUENT case and data files that are stored with the project but are no longer

needed. You should close FLUENT before deleting FLUENT case and data files from the project

directories.

Important

Monitor files are automatically written to the appropriate working directory within the

Workbench project files directory. You will not be able to specify a different path for monitor

files from within FLUENT. When reading older case files in which a different location is specified

for monitor files, a warning message will inform you that the path will be modified.
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Important

If you intend to use a FLUENT journal file that reads or writes files while running under

Workbench, the journal file and the files it references should be moved to the appropriate

FLUENT folder in the appropriate system folder in the Workbench project working directory.

File paths in the journal files should use relative paths to point to the new locations for the

files.

Important

If you use models that generate mesh-dependent information the first time they are set up

(e.g., DTRM, S2S) and then you change the mesh used in your system, the mesh dependent

information (e.g., .dtrm  file, .s2s  file) may be incompatible with the new mesh. To resolve

this issue, you can:

• Open FLUENT from your system, compute/write the .dtrm  or .s2s  output files, and then

update the system.

• Use a solution strategy and write the .s2s  file as a pre-initialization method using the ap-

propriate command (e.g., (write-sglobs "2d.s2s.gz") ).

Important

If your FLUENT setup involves compiling and loading a user-defined function (UDF), it is re-

commended that you copy the UDF source code files to the same location as your mesh and

settings files before compiling the UDF libraries. This location is available in the Files view

in Workbench. You may need to save the project first to create the appropriate files folder

within the Workbench project (e.g. project name ∖dp0∖FFF ∖Fluent ∖ ). If you

need to unload a UDF library for any reason during your simulation, it is recommended that

you save the project soon after unloading the library. If you archive a project that includes

compiled user defined functions, you will need to recompile the libraries after opening the

archived project. To do so, you will need to open FLUENT from the Setup cell, go to the UDF

Library Manager dialog box (Define → User Defined → Functions → Manage...) and unload

the existing UDF library. Next, rebuild the UDF library locally by going to the Compiled

UDFs dialog box (Define → User Defined → Functions → Compiled...), selecting the archived

.c  and .h  files, compiling, and loading the new UDF library. Finally, save the project.

For more information, please see the following section:

2.13.1. FLUENT File Naming in Workbench

2.13.1. FLUENT File Naming in Workbench

When running under Workbench, FLUENT automatically saves the settings, case, and data files for your

system as needed.

FLUENT names these files using the base name of the mesh file. If a mesh (or case) file is imported, the

base name of the imported file is used as the base name for the settings, case, and data files. If the

mesh is created in Workbench, the mesh file uses the system’s directory name as its base name.

When FLUENT saves a case file, it appends the base name with the run number. When FLUENT next

writes a case file, the run number is incremented in order to avoid overwriting the previous case file.
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When FLUENT saves a data file, it appends the base name with the same run number as the associated

case file and with the iteration (or time-step) number at which it was saved. A new case file is not

written every time that a data file is written. The case file is only written when the settings and/or mesh

is changed.

The following example shows how file naming works in FLUENT under Workbench. In this example, you

have a single Fluid Flow (FLUENT) analysis system and you have created the mesh in Workbench.

1. Double-click Setup cell. FLUENT launches and loads FFF.msh .

2. In ANSYS FLUENT, specify boundary conditions, initialize the solution and enter 10 iterations on the

Run Calculation task page.

3. In the FLUENT application, select the Calculate button.

FFF.set  file is written and 10 iterations are completed.

4. Save the project.

FFF-1.cas.gz  and FFF-1-00010.dat.gz  are written.

5. In the FLUENT application, select the Calculate button.

10 additional iterations are completed.

6. Save the project.

FFF-1-00020.dat.gz  is written.

7. In the FLUENT application, change the value of the inlet velocity, select the Calculate button. When

prompted, select the Store the modified settings for a future calculation and use them this time

option.

FFF.set  is written (overwriting the existing file) and 10 additional iterations are completed.

8. Save the project.

FFF-2.cas.gz  and FFF-2-00030.dat.gz  are written.

Important

The same naming convention is used when autosaving with FLUENT under Workbench.

2.14. Working with ANSYS Licensing

When working with Workbench, you have the option to share a single license between applications

that use the same license or the option for each application to check out its own license.

For more information, please see the following section:

2.14.1. Shared Licensing Mode

2.14.1. Shared Licensing Mode

When using shared licensing, although a single license is shared between multiple applications, only

one application can actively use the license at a time. Therefore, with just a single license, you can have

both ANSYS FLUENT and ANSYS CFD-Post open at the same time. If iterations are being performed in
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the FLUENT session, you cannot do anything in the ANSYS CFD-Post session. However, if the FLUENT ses-

sion is open and idle, you can work in ANSYS CFD-Post without closing FLUENT. Similarly, you can have

multiple sessions of FLUENT open at the same time using just a single license.

If you open an application, it will first check to see if it can use a license that is already checked out. If

it can, and that license is available, it will use that license. If the license is not available because it is

being used by another application, you will be informed that the required license is not available. You

will not be able to use the new application until that license becomes available. If there is not a license

checked out that is compatible with the new application, the new application will check out an addi-

tional license.

In shared mode, you can have multiple licenses of each type of non-shareable licenses checked out at

a time. For example, you can have 1 acfd  license and 1 acfd prepost  license checked out at the

same time but you cannot have 2 acfd  licenses checked out at the same time.

In shared mode, you can have multiple licenses of each type of non-shareable licenses checked out at

a time. Non-shareable licenses include solver-only licenses and parallel licenses.

For more information about licensing and shared license mode, please see the Workbench on-line

documentation.

2.15. Using FLUENT With the Remote Solve Manager (RSM)

The Remote Solve Manager (RSM) is a job queuing system used to distribute tasks that require computing

resources. RSM schedules and manages tasks within Workbench and allows tasks to be sent only to the

local machine to run in background mode, or they can be broken into a series of jobs for parallel pro-

cessing.

For more information about using FLUENT in Workbench and RSM (with associated limitations), see

Submitting Solutions for Local, Background, and Remote Solve Manager (RSM) Processes and Submitting

FLUENT Jobs to RSM.

2.16. Using Custom Systems

Workbench allows you to add custom templates and includes some pre-defined custom templates. To

use a custom template, double-click the template to add it to the Project Schematic.

Under Custom Systems in the Toolbox, there is a predefined FLUENT-based custom system (FSI: Fluid

Flow (FLUENT) − > Static Structural – the single arrow is meant to convey that the interaction is one-

way). When you double-click the template to add it to the Project Schematic, Workbench automatically

creates a link between the Geometry cell in the FLUENT system and the Geometry cell in the Structural

system and between the Solution cell in the FLUENT system and the Setup cell in the Structural system.

You can create your own system template and then save it as a Custom System by performing the

following steps:

1. Manually create the desired system diagram in the Project Schematic.

2. Right-click the white space in the Project Schematic and select Add to Custom from the context menu.
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Important

When you use FLUENT to perform a one-way fluid-structure interaction (FSI) analysis using

the approach demonstrated in the predefined FLUENT-based custom system, you can only

exchange surface data for force and thermal loads.

Important

When you use FLUENT to perform a one-way fluid-structure interaction (FSI) analysis using

the approach demonstrated in the predefined FLUENT-based custom system, and you are

performing a multiphase simulation in FLUENT, you cannot exchange thermal load data.

2.17. Using Journaling and Scripting with FLUENT in Workbench

You can keep a history of your interactions within Workbench, that can also include your interactions

within FLUENT, by recording your interactions with the program(s) in session journals (also referred to

as journaling). This is done using the Scripting submenu in the Workbench  File menu:

File → Scripting → Record Journal...

In addition, since the journal files are Python-based scripts, you can edit and/or play back previously

recorded journal files, or create new journals manually (also known as scripting), that include your inter-

actions within Workbench and, if applicable, any interactions within FLUENT:

File → Scripting → Run Script File...

For more information about recording and using session journals in Workbench, as well as reference

documentation containing available commands and properties, see the separate ANSYS Workbench

Scripting Guide.

Important

When using the Send Command method to directly call a FLUENT text user interface (TUI)

command, the TUI command will not be recognized unless you use double quotes around

it (e.g., setup.SendCommand("define model energy no") ). If a string is included

in the TUI command, then a backslash is required before the quotes around the string. For

example:

setup1.SendCommand(Command="(cx-gui-do cx-activate-item \"MenuBar*FileMenu*Close FLUENT\") ")

Important

FLUENT internal Scheme commands may not work properly when called directly using the

Send Command method. Therefore, you should use FLUENT text user interface (TUI) com-

mands instead.
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2.18. Performing System Coupling Simulations Using FLUENT in Work-

bench

You can use Workbench to perform coupled simulations using two or more systems (i.e., ANSYS Mech-

anical (e.g., Transient or Static Structural) and ANSYS FLUENT) using a System Coupling component

system. As described in the separate System Coupling Guide, you can set up a one-way or two-way

fluid-structure interaction (FSI) design analysis in Workbench by connecting a System Coupling component

system to your Mechanical system and to your ANSYS FLUENT fluid flow analysis system.

Connecting the Setup cell from an ANSYS FLUENT analysis system to the Setup cell for the System

Coupling component system signals the latter system that the ANSYS FLUENT solver wishes to act as

a co-simulation participant in a coupled analysis. Few coupling related settings are required in the ANSYS

FLUENT setup, as described in the section below. Instead, most of coupling related settings are made

through the System Coupling system’s Setup user interface. Once the coupling setup is complete, the

coupled analysis is executed by updating the System Coupling system’s Solution cell, rather than the

same cell in the connected co-simulation participant systems.

Additional information can be found in the following sections:

2.18.1. Supported Capabilities and Limitations

2.18.2. Regions and Variables Available for System Coupling

2.18.3. System Coupling Related Settings in FLUENT

2.18.4. How FLUENT’s Execution is Affected by System Couplings

2.18.5. Restarting FLUENT Analyses as Part of System Couplings

2.18.6. Running FLUENT as a System Coupling Participant from the Command Line

2.18.7.Troubleshooting Two-Way Coupled Analysis Problems

2.18.1. Supported Capabilities and Limitations

ANSYS FLUENT currently has the following capabilities when involved with the System Coupling:

• Support for the use of triangular & quadrilateral faced interface cell types

• Full dynamic mesh support everywhere except on coupling interface

• Local and distributed parallel

• Moving and deforming mesh specification on boundary wall regions using incremental displacements

obtained through System Couplings. (Note the additional System Coupling option in the Dynamic

Mesh Zones dialog box, see Specifying the Motion of Dynamic Zones for more information).

• Output of total force on all boundary wall regions. FLUENT is able to serve the total force variable

(viscous and normal) on all wall boundaries (with or without enabling the System Coupling option

in the Dynamic Mesh Zones dialog box).

Important

Note that using System Coupling in conjunction with the Remote Solver manager (RSM) is

not supported. If attempted, you will receive the following message:

Solution updates for FLUENT systems participating in System Couplings 
must run in the foreground. This change has been automatically applied.
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2.18.2. Regions and Variables Available for System Coupling

The following variables will be available on all boundary wall regions.

Table 2.2  Variables On Boundary Wall Regions

Physical TypeData TypeTransfer DirectionInternal NameDisplay Name

ForceVectorXYZ**0ForceForce

LengthVectorXYZ**1DisplacementIncremental Displacement*

* The Incremental Displacement variable is only available on walls with the System Coupling moving

and deforming mesh (MDM) option selected and will qualify as valid coupling regions.

** Represents the force vector �
ur

 ( ��, ��, ��) and the incremental displacements vector �
ur

 ( �,

	, 
) respectively.

Note

Forces on wall/wall-shadow pairs are not supported (e.g., two different fluids on either side

of a zero thickness internal wall in FLUENT).

2.18.3. System Coupling Related Settings in FLUENT

• Dynamic Mesh

– The System Coupling option must be selected on the desired moving and deforming wall

boundaries in order to obtain displacements from other co-simulation participants taking part

in the coupled analysis.

• Run Calculation

– When running as part of a transient coupled analysis, the step size for and duration of the analysis

are controlled by the System Coupling service.

→ The Time Step Size(s) specified in the FLUENT setup is currently ignored; the FLUENT solution

will be advanced using the time step size specified as part of the System Coupling setup.

→ The Number of Time Steps is also ignored.

– The specified Max Iterations/Time Step corresponds to the maximum number of non-linear solver

iterations performed per coupling iteration.

For steady-state, system–coupled FLUENT analyses, the System Coupling analysis settings override the

FLUENT calculation settings. The FLUENT system executes (N/M) solver iterations per coupling iteration,

where N is the number of solver iterations specified in the FLUENT Run Calculation task page, and M

is the maximum number of coupling iterations from System Coupling service. Note that a minimum of

5 solver iterations will always be executed per coupling iteration, regardless of the value given by (N/M).

For example, if the number of iterations in FLUENT is 50, and the number of coupling iterations in the

System Coupling service is 5, then the system–coupled FLUENT system will execute 10 solver iterations

per coupling iteration. Before executing the solver iterations, FLUENT gathers the incremental displace-

ment values from System Coupling service, applies the displacements, then updates the mesh.

For pseudo-transient cases, please refer to Performing Pseudo Transient Calculations in the FLUENT

User's Guide.
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For steady-state dynamic mesh applications, please refer to Steady-State Dynamic Mesh Applications

in the FLUENT User's Guide.

2.18.4. How FLUENT’s Execution is Affected by System Couplings

ANSYS FLUENT’s execution is modified slightly to allow the Coupling Service to manage the evolution

of the coupled analysis. These changes are summarized in Process Synchronization and Analysis Evolution

in the System Coupling User's Guide.

2.18.5. Restarting FLUENT Analyses as Part of System Couplings

ANSYS FLUENT writes out case and data files that contain information related to the simulation. The

case file contains the mesh, boundary and cell zone conditions, solution parameters for the simulation,

as well as information about the user interface and graphics environment. The data file contains the

values of specified flow field quantities for each mesh element and the convergence history (residuals)

for the flow field.

2.18.5.1. Generating Restart Files

Restarts of a system coupling analysis requires compatible restart points to exist in the coupling service

and in each of the solvers participating in the analysis. To facilitate this, FLUENT will automatically

generate the required case and data files based upon requests received from the System Coupling

service. Note that this is in addition to the restart points (or results) manually requested via the Autosave

Every field in the Calculation Activities task page within FLUENT.

2.18.5.2. Executing the Restart Run

Once the coupled analysis run is finished or interrupted, you can restart this run from any of the saved

restart points.

Important

The restart point selected in the FLUENT solver must be consistent with the restart points

selected for the System Coupling service and other coupling participants.

When the FLUENT solution is updated (or restarted), the case and data files corresponding to the current

solution point will be used, if they exist. The last generated case and data files form the current solution

point, by default. To specify an alternate current solution point, perform the following steps:

1. Double-click FLUENT’s Solution cell in Workbench.

Warning

Editing (i.e. double-clicking) the FLUENT Solution cell will clear all solution data and

restore the original mesh and settings.

2. Select File → Solution Files to open the Solution Files dialog box with a list of all available restart

points.

3. Select the desired restart point to make its mesh and data the current set used by FLUENT. By default,

the latest saved restart point is selected. Note that you can only select one restart point. Click the restart

point to select/deselect it.
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4. Click Read to read-in the data for the selected restart point.

5. Once the data is read, click Close to close the Solution Files dialog box.

6. Close FLUENT by selecting File → Close FLUENT.

In some cases, FLUENT setup changes are required to avoid failure of the coupled analysis (e.g. iteration

controls, under-relaxation factors, etc.). As noted above, the settings that are stored in the case file

corresponding to the current solution point will be used for FLUENT restarts. To modify the settings for

a restart, a new case file for the restart point must be created as follows:

1. Note the name of the case (and data) file that is loaded when the current restart (or solution) point is

read.

2. Make the desired setup changes.

3. Select File → Export → Case... and select the noted case file, and choose OK when prompted to

overwrite the existing case file.

4. Close FLUENT by selecting File → Close FLUENT.

If you are presented with a notification that the modified mesh and settings will be used for the current

run, choose OK to accept and close the dialog box.

2.18.6. Running FLUENT as a System Coupling Participant from the Command

Line

System Coupling analyses can be run via the command line (described in Executing System Couplings

Using the Command Line in the System Coupling User's Guide). To run ANSYS FLUENT as a coupling

participant, execute the following steps:

• Complete the System Coupling–related settings in FLUENT (see System Coupling Related Settings in

FLUENT (p. 63))

• Generate the case and data files needed to start FLUENT

– Choose Write and Case & Data from the File menu in the FLUENT graphical interface

• Start the coupling service and obtain the following information from the System Coupling Server

(SCS) file:

– the port and host on which the service is being run, and

– the identifier (or name) for FLUENT

• Use this SCS information to set the FLUENT–specific system coupling command line options (de-

scribed in System Coupling Options in the FLUENT User’s Guide).

• Note that if FLUENT is run in interactive mode, the interface will be locked from when it reports it

has established the connection to the coupling service until when all other coupling participants

do the same. This occurs so that all participants may be synchronized at the Initial Synchronization

point. For information about synchronization points, see Process Synchronization and Analysis

Evolution in the System Coupling User's Guide.

2.18.7. Troubleshooting Two-Way Coupled Analysis Problems

The following files, found in the FLUENT run directory (FFF/Fluent under a Workbench design point

directory), may prove useful in troubleshooting coupled analysis problems:
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• cortexerror.log : This file contains a historical summary of all of the errors that have occurred

during all runs executed in the same run directory. With this in mind, ensure that you are consid-

ering messages corresponding to the most recent run. An example message is: "Update-Dynamic-

Mesh failed. Negative cell volume detected.". This indicates that at the date and time noted, the

mesh unexpectedly failed.

• solution 1.log : This file includes information regarding the FLUENT boundary conditions at

which data from System Couplings was/is used. Please note that, like the cortexerror.log  file,

this file contains a historical summary for all runs executed in the same run directory.

• solution.trn  (or other transcript file): This file contains a complete summary of the current/latest

run's evolution. This is one of the most useful files to determine why the coupled analysis failed.

To generate extensive debug output during the analysis, enter the following command when

completing the FLUENT problem setup:

(rpsetvar 'sc/verbosity 1)  

Please provide all of these files when submitting a request for service to ANSYS personnel.

2.19. Performing FLUENT and Ansoft Coupling in Workbench

FLUENT can be coupled with the Ansoft Maxwell application within Workbench in order to perform a

one way electromagnetic-thermal interaction problem. The coupling involves solving an electromagnetic

problem in the Ansoft Maxwell application, and mapping the resulting volumetric loss information onto

the solid cell zones of your FLUENT mesh. The loss information is mapped onto the cell centroids, and

is considered a heat source (load) that is added to the energy equation. This capability is useful for

applications such as simulating fluid flow around or inside electromechanical (EM) devices, when the

temperature of the device is influenced by electromagnetic or electrical losses.

The overall workflow for an Ansoft-FLUENT analysis is as follows:

1. Create and solve the electromagnetic application using Ansoft Maxwell.

2. Drag and drop a FLUENT–based system and import a case or mesh file into FLUENT, and then double-

click the Setup cell to start FLUENT.

Note

If you import a mesh into FLUENT that was generated using non-SI units, then you

should scale and/or translate the mesh before you perform any coupling with Ansoft.

3. Drag and drop the Solution cell of the Ansoft system onto the Setup cell of FLUENT system to enable

the data transfer.

4. Update the Solution cell of the Ansoft system.

5. Refresh the Setup of FLUENT system.

6. Specify the EM settings in FLUENT (File → EM Mapping).

7. Set up the FLUENT analysis as you normally would (e.g., specify boundary conditions, solution settings,

etc.).

8. Solve the FLUENT analysis.
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Important

Currently, only the Ansoft Maxwell application is supported (not HFSS or Q3D) for one–way

coupling between Ansoft and FLUENT in Workbench.

Important

The coupling between Ansoft and FLUENT in Workbench is not supported on Windows Vista

(32 bit and 64 bit), Red Hat 6, and SUSE Linux Enterprise Server 11.

Note

During EM mapping, FLUENT automatically turns on the energy model, if you have not already

done so.

Note

In 2D axisymmetrical cases only, Maxwell uses the RZ (or XZ) plane while FLUENT uses the

XY plane by default. Therefore, when you export a geometry from Maxwell, you need to rotate

the geometry in order for FLUENT to mesh the geometry before EM mapping can take place

properly. This is not a concern for regular 2D or 3D cases. For those who use ANSYS

DesignModeler, rotate the geometry exported from Maxwell by performing the following

steps:

1. Define a new plane based on the XY plane, applying a 90 degree rotation along the X

axis, and a 90 degree rotation along the Y axis.

2. Move the geometry from the XY plane to the new plane.

67
Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Performing FLUENT and Ansoft Coupling in Workbench



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.68



Appendix A. The FLUENT Menu Under Workbench

When FLUENT is running within Workbench, the FLUENT File and Mesh menus are slightly different.

The differences are described in the sections that follow:

A.1. File/Refresh Input Data

A.2. File/Save Project

A.3. File/Import/Mesh...

A.4. File/Import/Case...

A.5. File/Import/Data...

A.6. File/Import/Case and Data...

A.7. File/Export/...

A.8. File/EM Mapping/Volumetric Energy Source...

A.9. Mesh/Recorded Mesh Operations...

The common functionality for stand-alone FLUENT is documented in the separate FLUENT User’s Guide.

A.1. File/Refresh Input Data

The File/Refresh Input Data menu item allows you to refresh your FLUENT input data from within

FLUENT. This option is only enabled if new input data exists, or if a parameter value has changed. For

more information, see Refreshing FLUENT Input Data (p. 28).

A.2. File/Save Project

The File/Save Project menu item allows you to save your current Workbench project within FLUENT,

along with your current FLUENT case and/or data files. For more information, see Saving Your Work in

FLUENT with Workbench (p. 15).

A.3. File/Import/Mesh...

The File/Import/Mesh... menu item opens the Select File dialog box which allows you to select the

appropriate mesh file to be read. For more information see Importing Mesh, Case, and Data Files (p. 23).

A.4. File/Import/Case...

The File/Import/Case... menu item is used to read in a FLUENT case file (extension .cas ), or a mesh

file (extension .msh , .grd , .MSH, or .GRD) that has been saved in the native format for FLUENT. See

the  User's Guide for details.

The File/Import/Case... menu item opens the Select File dialog box which allows you to select the

appropriate file to be read. For more information see Importing Mesh, Case, and Data Files (p. 23).
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A.5. File/Import/Data...

The File/Import/Data... menu item is used to read in a FLUENT data file (which has a .dat  extension)

or parallel data file (which has a .pdat  extension). This menu item will not be available until you read

in a case or mesh file. See the separate FLUENT User’s Guide for details.

The File/Import/Data... menu item opens the Select File dialog box which allows you to select the

appropriate file to be read. For more information see Importing Mesh, Case, and Data Files (p. 23).

A.6. File/Import/Case and Data...

The File/Import/Case & Data... menu item is used to read in a FLUENT case file and the corresponding

data file (e.g., myfile.cas  and myfile.dat ) together. See the separate FLUENT User’s Guide for

details.

The File/Import/Case & Data... menu item opens the Select File dialog box which allows you to select

the appropriate files to be read. Select the appropriate case file, and the corresponding data file (i.e.,

the file having the same name with a .dat  extension) will also be read in. For more information see

Importing Mesh, Case, and Data Files (p. 23).

A.7. File/Export/...

When running under Workbench, several commands located under Write option under the File menu

have been moved to the Export option under the File menu. The new commands are:

File → Export → Case

File → Export → Data

File → Export → Case & Data

File → Export → PDF

File → Export → ISAT Table

File → Export → Flamelet

File → Export → Surface Clusters

File → Export → Profile

File → Export → Boundary Mesh

These items are used when you want to manually export a file independent of the project. Files exported

in this way are not used by the project unless you later import them into a new system. When you use

an Export command, you can export the files to the location of your choice with a name of your choice.

There is no need to export files since Workbench always saves the files it needs automatically. These

export commands are provided for your convenience when you want to save a specific file for later

use.
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A.8. File/EM Mapping/Volumetric Energy Source...

The File/EM Mapping/Volumetric Energy Source... menu item opens the Maxwell Mapping Dialog

Box (p. 71).

Important

EM Mapping is only available in serial ANSYS FLUENT under Workbench. It is not available

in parallel ANSYS FLUENT.

A.8.1. Maxwell Mapping Dialog Box

The Maxwell Mapping dialog box allows you to map the volumetric loss results from an Ansoft Maxwell

electromagnetic simulation onto the centroids of solid cells in the ANSYS FLUENT mesh as a heat source.

Controls

FLUENT Cell Zones

contains a list of solid cell zones from the FLUENT mesh, onto which the loss information can be mapped.

For these zones, FLUENT requests the heat source (loss) terms from the Ansoft application. By default

all solid zones are selected.

Transfer Definition

contains elements related to the transfer of data, including:

Solution

contains available solution sets. Since the Ansoft application may have multiple solutions, FLUENT

will request the generated heat source data for the selected solution.

Frequency

(only available for steady simulations) contains available frequencies. FLUENT will request that the

Ansoft application provide the heat source data for the selected frequency.

Start time

(only available for transient simulations) contains the simulation start time. The Ansoft application

will request to consider the selected time as the start time.

End time

(only available for transient simulations) contains the simulation end time. The Ansoft application

will request to consider the selected time as the end time.
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A.9. Mesh/Recorded Mesh Operations...

The Mesh/Recorded Mesh Operations menu item allows you to view common mesh manipulation

operations that you perform within FLUENT while working in Workbench. For more information, see

Reviewing Mesh Manipulation Operations in FLUENT (p. 40).
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